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Introduction This guide contains instructions for configuring and 
working with BOSâNOVA Web and  is designed for the 
BOSâNOVA Web User.
For other information about BOSâNOVA Web, refer to the 
documents listed on the following page.
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Table 1: BOSâNOVA Web Documentation Suite

Title Format Audience Contents

Installation Guide Printed manual person installing 
BOSâNOVA Web

A Quick Install sheet.  The instructions con-
tained on this sheet are often enough to suc-
cessfully install BOSâNOVA Web.

Online Help HTML, opens in a 
browser

Administrator and 
users

Context specific help topics for every dialog 
box plus a general, fully indexed, HTML Help.

System Administra-
tor’s Guide

PDF, opens in Acro-
bat Reader

System Adminis-
trator

Instructions for installing, configuring, and 
uninstalling the BOSâNOVA Web system.

User’s Guide PDF, opens in Acro-
bat Reader End users Instructions for using display and printer ses-

sions.

Release Notes A .txt file available 
from the CD-ROM

System Adminis-
trator

Information about changes from previous ver-
sions, late-breaking news, and errata.
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Components of the BOSâNOVA Web System

The BOSâNOVA Web System includes two parts:
Server
Can be set up either on a PC (running Windows NT, 2000, 
XP, or 2003) or on an iSeries host that has a Java Virtual 
Machine available.
Client
End-users can run BOSâNOVA Web display and printer 
sessions from a Web browser that supports the Java 2 
platform, Enterprise Edition™.  The user simply opens a 
Web browser and enters the IP address (or Domain 
Name) of the PC or iSeries acting as the BOSâNOVA 
Web server.  A Java applet automatically opens and a 
BOSâNOVA Web frame is displayed in the browser win-
dow.

Features of the BOSâNOVA Web System

BOSâNOVA Web is an enterprise-wide, centrally man-
aged, Java-based solution that provides iSeries-to-
desktop TN5250e GUI emulation and printing facilities.  
Computer users connected to an iSeries via an Intranet, 
Extranet, or the Internet access this application through 
any Web browser that supports the Java 2 platform, 
Enterprise Edition™.
BOSâNOVA Web can be housed on an iSeries or a PC 
with Windows NT/2000/XP/2003, where it is maintained 
and managed.  BOSâNOVA Web’s security features, 
based on SSL and industry-standard encryption mecha-
nisms, ensure a safe and secure connection to the iSeries 
via the Web.
Part of BOSâNOVA Web's power is the ability to control 
access via the use of different access points:
• Users running sessions over a normal (non-secure) 

connection use the http protocol and the non-secured 
http BOSâNOVA Web server port.

• Users running sessions over a secure (SSL) connec-
tion use the https protocol and one of the https 
BOSâNOVA Web server ports.  This can be with or 
without client authentication.

• To access the User Configurator, use User.html
• For the Administrator Configurator, use Admin.html
The BOSâNOVA Web System also:
    
Previous Page Contents 3 Index Next Page



BOSâNOVA Web User Guide
• Provides iSeries display and printing emulation.
• Provides SQL-based data transfer.
• Employs the SSL protocol, industry-standard encryp-

tion algorithms, and BOSâNOVA Web server login 
authentication to ensure secure and confidential com-
munication between the server and clients.

• Includes MorphMaster, a tool which instantly converts 
legacy screens to full-color, mouse-sensitive  screens 
complete with panels, popup windows, buttons, and 
more,  all without altering the underlying legacy 
screens. 

• Includes a full SCS Windows printing plug-in installed 
and initiated via the browser.

• Deploys automatically to all Internet or network-
attached workstations using a Web browser.

• Includes a “thin” Web server that runs on the 
BOSâNOVA Web server, eliminating the need for an 
existing Web server.
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Getting Started 
with BOSâNOVA 

Web

This section includes:
• “System Requirements” on page 6
• “Installing BOSâNOVA Web” on page 7
• “Logging In” on page 10
• “Running Sessions” on page 11
• “Using the Sessions Table” on page 12
• Client 4.x, p. 14
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Table 2: System Requirements for End-Users Computer

Processor OS Memory Java VM Connection

PC Pentium 230 MHz 
or higher

Windows 95/98/ or Window NT/
2000/XP 128 MB minimum

Sun Java Plug-in 
1.4.1 and higher 
or Microsoft Java 
1.1

TCP/IP

Browser Requirements

BOSâNOVA Web display and printer sessions run on the following browsers:
• Microsoft Internet Explorer, version 5 and higher
• Netscape, version 6 and higher
• Mozilla 1.3    

NOTE:  Ensure that the browser supports the Java 2 platform, Enterprise Edition™.  Refer to the 
Computer Requirements listed above.
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Installing BOSâNOVA Web

The BOSâNOVA Web Client includes two components. 
• the Java applet
• the BOSâNOVA Web Spooler, that is, the printing cli-

ent
These are downloaded from the server both the first time 
the user connects to the server and during a software 
upgrade.   

Installing the Java Applet

To install the Java applet:
1. Ensure that the BOSâNOVA Web administrator has 

given you the information required in step #3.
2. On your computer, open a Web browser. 
3. In the browser’s address field, enter the data provided 

by your BOSâNOVA Web administrator:
a. For non SSL connections:  http://

For SSL connections:https://
b. The IP address or Domain Name (DN) for the 

iSeries or PC acting as the BOSâNOVA Web 
server.

c. The http or https port number.  
For example:
non SSL connections:
http://194.90.180.80:8080
   IP address or DN :   port
SSL connections:
https://194.90.189.80:4443
   IP address or DN :   port 

4. Press Enter.  Your browser will connect to the 
BOSâNOVA Web server.  
The BOSâNOVA Web server home page is displayed.
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NOTES:  If the browser fails to connect to the iSeries or computer 
where the BOSâNOVA Web server is running, contact your 
BOSâNOVA Web administrator.

5. Click either:
BOSâNOVA Web Client
This options runs the most recent version of 
BOSâNOVA Web.
BOSâNOVA Web Client version x.5
This option runs the older, Java 1.1 client.

6. Continuation of the installation differs per web 
browser.  The difference is explained below.
• For Internet Explorer Users with Sun J2SE:  

A security warning, similar to the one below, is 
displayed.  Click Yes.

              

• For Internet Explorer Users with MS Java 1.1:  
A security warning, similar to the one below, is 
displayed.  Click Install.

              

• For Netscape Navigator Users with Sun J2SE:  
i. The Java Plug-in screen opens.  Select Grant 

this session or Grant always.
ii. The Java Security screen opens.  Select 

Remember this decision and click Grant.

NOTE:  If the user runs the MS Java applet and is allowed to run 
display sessions, then the BOSâNOVA Fonts are downloaded and 
installed into his Windows font directory on the first login.
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Installing the BOSâNOVA Web Spooler

If the user is allowed to run printer sessions—both after 
the initial login and when updates are available—
BOSâNOVA Web Spooler is installed automatically.  The 
message “BOSâNOVA Web Spooler installation, please 
wait …” is displayed.  Then, this standard progress screen 
is displayed:

              

Upon completion, the Sessions table is displayed.
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Logging In

To log-in to BOSâNOVA Web:
1. From any computer, open a Web browser. 
2. In the browser’s address field, enter the BOSâNOVA 

Web Server address.  (Your system administrator 
must give you the address.)  

3. Press Enter.  The server home page is displayed.

NOTE:   BOSâNOVA Web can be configured to bypass the login 
screen.  In that case, the first screen is the sessions table.

4. Click BOSâNOVA Web Client.  The Log-in screen is 
displayed.

              

5. Enter your Username and Password.  

6. Clear or select Run Default Sessions.  When 
selected, BOSâNOVA Web runs the iSeries sessions 
designated as default sessions.

7. Click Log In Now.  

NOTE:  If a user is allowed to run printer sessions—after the initial 
login and when updates are available at the server—the 
BOSâNOVA Web Spooler installation program runs.  See “Installing 
the BOSâNOVA Web Spooler” on page 9.

The Sessions Table is displayed.  Available sessions 
are listed on the Sessions Table.

              

Figure 1: The Sessions Table
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Running Sessions

Your BOSâNOVA Web administrator can configure and 
assign to you several sessions of each type. Each ses-
sion can have different permissions and each can connect 
you to a different iSeries host computer.

Running a Single Session

To run a single session:
1. Log-in to BOSâNOVA Web.  (See “Logging In” on 

page 10.)
2. Select a session.
3. Right-click the session.  A popup menu is displayed.

              

4. Click Start.

Running All Sessions

To run all sessions:
1. Log-in to BOSâNOVA Web.  (See “Logging In” on 

page 10.)
2. Click Options.  The Options menu is displayed.

              

3. Click Start All.
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Using the Sessions Table

Use the Sessions Table to complete the following tasks.

Associating Printers

To associate a Windows printer with a session:
1. Log-in to BOSâNOVA Web.  (See “Logging In” on 

page 10.)
2. Click Options.  The Options menu is displayed.
3. Click Associate printers.  A message is displayed 

indicating that all active sessions will be closed.
4. Click Yes.  The Associate Printers dialog box is dis-

played.  
              

• If the Administrator associated the session profile  
with the default Windows printer, its name is listed.

• If not, the words “No Printer” are listed.

5. Select a row.
6. Click Associate Printers.  The Select a Windows 

Printer dialog box is displayed.
              

7. Select a printer and click OK.  The new association is 
displayed in the table.

              

8. Click Save.  The Sessions Table is restored and all 
printer sessions are reactivated.
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Viewing Session Properties

To view session properties:
1. Log-in to BOSâNOVA Web.  (See “Logging In” on 

page 10.)
2. Select a session.
3. Right-click the session.  A popup menu is displayed.
4. Click Properties.  Either the Print Session or the Dis-

play Session Properties window is displayed.
              

Requesting Help

You can send a request for help to the System Adminis-
trator.  The Help Request is displayed in the Adminis-
trator’s Configurator.  
To send a request for help:
1. Log-in to BOSâNOVA Web.  (See “Logging In” on 

page 10.)
2. Click Options.  The Options menu is displayed.
3. Click Help alert.  A request is sent which includes the 

originating PC’s IP address.
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Installing Client x.5

NOTE:  This procedure can be performed only for BOSâNOVA 
Web version 4.x with Java 1.1.  Due to limitations inherent in Java 
2, BOSâNOVA Web x.6, which runs on Java 2, cannot be installed 
from the CD-ROM.

Under most circumstances, installation of BOSâNOVA 
Web occurs when you log in.  This process is described in 
the section, “Logging In” on page 10.
However, if you have a slow internet connection, you can 
install these BOSâNOVA Web Clients from the BOS CD-
ROM:
• BOSâNOVA Web Client for display emulation ses-

sions without security.
• BOSâNOVA Web Client SSL for display emulation 

sessions with security.

Installing Either Web Client

To install BOSâNOVA Web Client and BOSâNOVA Web 
Client SSL:
1. Insert your BOS CD-ROM into the computers 

CD-ROM drive.  
2. From the Welcome screen, select Install Your 

Product.
3. Follow the prompts and enter your BOSâNOVA Web 

CD-Key.
4. From the Welcome to the BOS family screen, select 

BOSâNOVA Web Client and follow the prompts. The 
Welcome screen may appear momentarily in the 
background.

5. From the Setup screen, select either BOSâNOVA 
Web Client or BOSâNOVA Web Client SSL.  Setup 
opens your default browser and installs the 
BOSâNOVA Web Client in the browser.  Upon com-
pletion, the BOSâNOVA Web Log-in screen is dis-
played.  A message advises you to connect to the 
BOSâNOVA Web server.

6. Enter the IP address of the BOSâNOVA Web server.  
The BOSâNOVA Web Log-in screen is displayed, this 
time without the message.

7. Log-in.
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Configuring 
BOSâNOVA Web

This section includes:
• An Overview of the User Configurator, p. 15.
• Modifying your Password, p. 16.
• Defining Default Sessions, p. 16.
• Using Sign-on Bypass, p. 17.
• Working with SSL Certificates, p. 17.
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The User Configurator

To log-in to the BOSâNOVA Web User Configurator:
1. From any computer, open a Web browser.
2. Enter the BOSâNOVA Web home page address.  
3. Press Enter.  The BOSâNOVA Web server home 

page is displayed.
                

4. Click User Configurator.  
5. Enter your User name and Password and press Enter.  

The User Configurator screen opens.

              

The User Configurator contains the following options:
Change Password
Select Change Password to change the password you 
use to log in to BOSâNOVA Web.
Default Sessions
Select this item to designate default sessions, that is, ses-
sions that will open when Run Default Sessions is 
selected (see p. 10).
Sign-on Bypass
BOSâNOVA Web supports a Sign-on Bypass connection 
which enables BOSâNOVA Web to skip user identification 
when connecting to the iSeries (see p. 17).
SSL
BOSâNOVA Web supports the SSL (Secure Sockets 
Layer) protocol, which creates a bidirectional, secure con-
nection between the server and the client. If your 
BOSâNOVA Web administrator set up a secure connec-
tion for you, you will need to download the certificate.
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Run Sessions
Select this item to display the Log-in screen.  After you log 
in, all sessions that have been defined for you by your 
BOSâNOVA Web administrator appear in a list (see 
Installing BOSâNOVA Web on page 7).

NOTE:  If Change Password and/or Default Sessions are not 
displayed, your BOSâNOVA Web Administrator did not give you 
access to these options.

Modifying Your Password

Use the Change Password screen to change your 
BOSâNOVA Web User password (not the host password).  
However, you cannot change your password if your user 
configuration:
• Was defined with “Check password via host” or
• Does not include the “Allow user to configure pass-

word” permission.
To change your password:
1. From the User Configurator, select Change Pass-

word.  The Change Password screen opens.
2. Enter a password in the New password field.
3. Re-enter the password in the Verification field.
4. Click OK.

Defining Default Sessions

Use the Default Sessions screen to designate default ses-
sions, that is, sessions that will open when Run Default 
Sessions is selected (see p. 10).
All sessions appearing in this list were defined for you by 
your BOSâNOVA Web administrator.
To define default sessions:
1. From the User Configurator main screen, select 

Default Sessions. The Default Sessions screen 
opens.

              

2. Select the checkbox next to one or more sessions.
3. Click OK.
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Sign-on Bypass

Sign-on Bypass enables you to skip user identification 
when connecting to the iSeries.  Sign-on Bypass applies 
to display and JDTF sessions.

NOTE:  When using Check password via host, Sign-on Bypass 
is not needed for the host the password is checked with (see 
Adding Users in the Administrator’s Guide).

To set up user Sign-on Bypass:
1. From the User Configurator main screen, select Sign-

on Bypass. The Sign-on Bypass screen is displayed.
              

2. Enter your User ID and Password.
3. Confirm your password by typing it again in the Verifi-

cation field and click OK.

Working with SSL Certificates

The following table lists the browser requirements for use 
of certificates.  Requirements differ depending upon the 
connection type defined for the user by the BOSâNOVA 
Web System Administrator.

              

Table 3: Requirements for Certificates

Connection 
Type

Default 
Port 

Number

Server 
Root 
Cert.

User 
Root 
Cert.

User 
Cert.

Non secure 8080 No No No

SSL 4443 Yes* No No

SSL with user 
certificate 
authentication

4444 Yes* Yes Yes

* Only if a self-signed SSL certificate is used for 
issuing the server certificate. If the server certifi-
cate is issued by a well-known Certificate Authority 
(e.g., Verisign or Thawte), then you don’t need to 
install the root certificate in the browser.  The stan-
dard browser installation includes root certificates 
of the most popular Certificate Authorities.
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User SSL Configuration Wizard

The wizard checks the SSL configuration on the 
BOSâNOVA Web server and identifies the steps that must 
be performed in order to configure the browser.
There are two steps that can be performed:
• Installing a root server SSL certificate: 

This step will be performed only if the server SSL cer-
tificate is signed by another self-signed certificate that 
was generated by the BOSâNOVA Web server.

• Generating and installing a client certificate: 
This step will be performed only if the following two 
conditions exist:
• The connection type defined by the BOSâNOVA 

Web administrator is SSL with authentication.
• The Wait for certificate option is selected in the 

User Properties screen.
To launch the SSL configuration wizard:
1. Using a browser, connect to the BOSâNOVA Web 

User Configurator.
2. Log-in with your user name and password.
3. From the User Configurator main screen, select SSL. 

The User SSL Configuration Wizard is launched.
If the server SSL certificate is signed by another self-
signed certificate that was generated by the 
BOSâNOVA Web server, and the user’s connection is 

SSL with authentication with the Wait for certificate 
option, then the screen below is displayed.

              

4. Click Next. The Install Root Certificate screen opens.  
The instructions displayed on the Install Root Certifi-
cate screen differ depending upon the type of Internet 
browser being used. 

5. Click Install Certificate and follow the Internet 
browser’s prompts.

6. When the server root certificate has been installed, 
click Next to continue. 

7. The Client Certificate Request screen opens.  This 
screen is used for generating and installing the user 
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certificate.  You will see certificate parameters that 
were taken from the user root certificate. 
a. Enter the name of your organization unit.
b. Select the public key length (for Netscape browser 

only). 
c. Click Next.
The Internet browser will generate the public/private 
key pair, generate a Certificate Signing Request 
(CSR), and send it to the BOSâNOVA Web Certificate 
Manager.  If you are using a Netscape browser then 
you will be prompted to define a password for the 
Communicator Certificate DB.  Don’t forget this 
password because you will be prompted for it when 
you connect to the BOSâNOVA Web server.
The Certificate Manager will generate the user certifi-
cate, sign it by the user root certificate, create the cer-
tificate list that consists of the user root certificate and 
the newly created user certificate, and send this list 
back to the browser.  The Install Client Certificate 
screen opens.

8. Click Install Certificate to install the received certifi-
cate list in the browser certificate database.

SSL Certificates and BOSâNOVA Web 6.x with Java 2

To use Client certificates with BOSâNOVA Web version 
6.x with Java 2, the following is required:
• the BOSâNOVA Web client must run over Java Plug-

in 1.4.2—not a lower version
• the BOSâNOVA Web client must be running over a  

Microsoft Windows operating system
• you must be using Internet Explorer.
To use client certificates over Java Plug-in 1.4.2 or higher:
1. Complete the steps listed in the previous section, 

“User SSL Configuration Wizard” on page 18.
2. From the Internet Explorer menu, select Tools > 

Internet Options > Content > Certificates.
3. Select the Personal tab.
4. From the “Personal certificates” list, select the certifi-

cate just installed.
5. Click Export and run the Certificate Export Wizard.
6. Select Yes, export the private key.
7. Ensure that the "Delete private key" option is cleared.  

Continue with the Wizard.
8. When the export is completed:

a. Open the Control Panel.
b. Select Java Plug-in.  
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c. There are two options:
• For Java 1.4.x, select the Advanced tab.
• For Java 1.5.x, select the Java tab and click 

View.
The Java Runtime Settings screen is displayed.

              

9. Add the following three lines in the “Java Runtime 
parameters” field.  Make sure to leave a space at the 
end of each line: 
Djavax.net.ssl.keyStore=g:\temp\secur3.pfx

Djavax.net.ssl.keyStorePassword=secur3

Djavax.net.ssl.keyStoreType=PKCS12

The underlined text are values which were defined 
during the Certificate Export Wizard, that is, the file 
path of the exported certificate and the certificate 
password.  They must be set according to the values 
you defined during the Certificate Export Wizard.

Exporting User Certificates

A BOSâNOVA Web user can generate a certificate only 
once.  If you are using different Internet browsers or dif-
ferent computers, you must export the installed certificate 
into a file and then import it into another browser.
To export a certificate from Microsoft Internet Explorer 
(MS IE):
1. Select View > Internet Options > Content > Per-

sonal in MS IE v4.x or Tools > Internet Options > 
Content > Personal in MS IE v.5.x.

2. Select your certificate from the list.
3.  Click Export.

• If you are using MS IE v.4.x, you will be prompted 
to define a password and a filename.

• If you are using MS IE v.5.x, then the Certificate 
manager Export Wizard will be launched. You 
must response to the wizard steps in the following 
way:
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• To export a certificate from a Netscape browser:
i. Select Communicator > Tools > Security 

Info > Certificates > Yours.
ii. Select the certificate and click Export.
iii. Follow the prompts and enter:

• A password for the Communicator 
Certificate DB.

• A password to protect the data being 
exported.

• The filename.

Importing User Certificates

To import a certificate into Microsoft Internet Explorer (MS 
IE):
1. Select:

•  View > Internet Options > Content > Personal 
in MS IE v4.x

• Tools > Internet Options > Content > Personal 
in MS IE v.5.x.

2. Click Import. You will be prompted to define a pass-
word and a filename.

NOTE:  Certificates with 1024-bit keys generated in a Netscape 
browser can’t be imported into MS IE European edition because 
this version has a limitation for the public key length due to U.S. 
government export restrictions.

To import a certificate into a Netscape browser:
1. Select Communicator > Tools > Security Info > 

Certificates > Yours.
2. Click Import a Certificate.
3. Follow the prompts and enter:

a. A password for the Communicator Certificate DB.
b. A password to protect the data being exported.
c. The filename.

Table 4: 

Step Response

Export private 
key with certifi-
cate

Select the Yes, export the private 
key option.

Certificate 
Export File

Select the Include all certificates 
in the certification path option.
    
Previous Page Contents 21 Index Next Page



BOSâNOVA Web User Guide
If you are using a self-signed server certificate on the 
BOSâNOVA Web server, you must install the server root 
certificate in the browser.
To install, connect to BOSâNOVA Web User Configurator 
and select SSL.  The User SSL Configuration Wizard will 
guide you in installing this certificate.
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The Display 
Emulation

This section includes:
• Working with the Display Emulation, p. 24
• Customizing the Display Emulation, p. 30
• Working with Macros, p. 39
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Working with the Display 
Emulation

Emulation includes the following features:
• Includes MorphMaster, a tool which instantly converts 

legacy screens to full-color, mouse-sensitive,  screens 
complete with panels, popup windows, buttons, and 
more,  all without altering the underlying legacy 
screens.

• Supports 3477FC devices (132-column display with 
color).

• Supports PC styles for keyboards, allowing you to 
work with either a 101-key or 102-key keyboard.

• Includes comprehensive keyboard mapping and cus-
tomization, using the Shift, Alt and Ctrl function keys, 
etc.

• Supports full-screen mode.
• Supports user-definable macros, including the option 

to set automatic sign-on and sign-off macros.
• Includes enhanced right-click popup menus.
• Includes enhanced copy and paste options.

Starting the Emulation

To start the display emulation:
1. Log-in to BOSâNOVA Web.  (See “Logging In” on 

page 10.)
2. Select a session.
3. Right-click the session.  A popup menu is displayed.

              

4. Click Start.

NOTE:  If you set the Sign-on Bypass option, or have Check 
password via host assigned in your user configuration, you do not 
need to sign in to each iSeries session.
    
Previous Page Contents 24 Index Next Page



BOSâNOVA Web User Guide
The Emulation Menus

Following are explanations of the items available from 
each of the emulation menus.

NOTE:  The Administrator can customize your menu content.  
Therefore, some of the menus might not be available.

Session Menu

The Session menu contains the following items:
New Session
Opens a new display session.
Save Workspace
Saves the workspace as is, including any customization 
changes you made (see p. 27).
Print Screen
Prints the current screen directly to your default printer 
(see p. 27).
Exit
Stops and exits the emulation (see p. 27).

Edit Menu

The Edit menu contains the following items:
Copy
Copies selected text according to the selected copy 
mode.  See “Copying & Pasting” on page 28.

NOTE:  The Copy and Paste commands are operational only when 
using the Legacy (green text) screen.

Paste
Pastes text according to the selected paste mode.  See 
“Copying & Pasting” on page 28.
Copy Mode
Point to this item to display the two copy mode options, 
Copy Continuous and Copy by Line. 
Paste Mode
Point to this item to display the three paste mode options, 
Paste Continuous, Paste Tab, and Paste Field Exit.

View Menu

The View menu contains the following options:
Picture
Searches the server’s images\viewer directory to locate 
an image file whose name matches a word selected on 
the display session screen (see p. 29).  
Ruler
Hides or toggles through the three ruler formats (see. 
p. 38) 
Toolbar
Hides or shows the toolbar (see p. 32).
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Full Screen
Sets full-screen mode (that is, without the emulation 
menus, toolbar, and task bar) (see p. 30).
MorphMaster
Sets MorphMaster mode, which converts your original 
host screen into a full-color, mouse sensitive screen with 
buttons, panels, and more (p. 45).
Test Mode
Shows the display attribute’s location.  The value is dis-
played in the Java Console as the pointer is over the dis-
play attribute.  Test Mode can be used only from a Legacy 
(green) screen. 

Macro Menu

The Macro menu contains the following items:
Macro Organizer
Opens the Macro Organizer (see p. 39).
Record Macro
Starts the process of recording a new macro (see p. 40).
Pause
Temporarily stops the process of recording a new macro
(see p. 40).
Stop Macro
Stops the process of recording a new macro (seep. 40).
Play Macro
Plays a selected macro (see p. 40).

Option Menu

The Option menu contains the following items:
Display
Opens a screen where you can change the display 
attributes of a display session.  See “Display Color 
Attributes” on page 32.
Keyboard Mapping
Opens a dialog box where you can map/customize your 
keyboard.  See “Creating or Editing a Keyboard Mapping” 
on page 37.
Toolbar Customization
Opens a dialog box where you can customize the emula-
tion toolbar.  See “Customizing the Toolbar” on page 30.
Exclude
Opens a dialog box for configuring MorphMaster to ignore 
specific elements from the current screen; MorphMaster 
will not convert these elements.  See “Excluding Elements 
from Conversion” on page 46. 

NOTE:  Exclusions defined in the Exclude dialog box are different 
than exclusions defined in a Rule base (see p. 55).  Exclusions 
defined in the Exclude dialog box prevent MorphMaster from 
converting elements in the open screen only. 

MorphMaster Customization
Opens the MorphMaster Customization dialog box.  Use 
the MorphMaster Customization dialog box to build a Rule 
base that directs MorphMaster’s identification of screen 
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elements and to customize Styles that define the appear-
ance of the MorphMaster screen.  See “Customizing Mor-
phMaster” on page 47.

Help Menu

The Help menu contains the following items:
Contents
Opens the emulation Help files.
About
Displays product information including version number 
and copyright.

Stopping the Emulation

To exit the emulation, select one of the following:
• From the Session menu, click Exit.
• From the Sessions table, select a session and right-

click.  From the popup menu, click Stop.
A confirmation message, similar to the following, is 
displayed.

              

Saving the Emulation Workspace

If you want to save your workspace as is, including any 
customization changes you made, select one of the fol-
lowing before stopping the emulation:
• From the Session menu, select Save Workspace.
• Press CTRL + S on the keyboard.

 Printing a Screen

You can print the current screen directly to your default 
printer.
To print a screen, select one of the following:
• From the emulation Sessions menu, select Print 

Screen.
• Press CTRL + P on the keyboard.
• Right-click, point to Session, and click Print screen.
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Copying & Pasting

Both copying and pasting are performed according to the 
preselected mode.  

NOTE:  The Copy and Paste commands are operational only when 
using the legacy (green text) screen.

To copy:
1. From the Edit menu, point to Copy mode.
2. Select the copy mode:

Copy Continuous
If this mode is selected, all copy actions will copy the 
text of the screen or the selected area as a single 
block, even if the original appears in different columns 
or rows.  The BOSâNOVA Web emulation interprets 
this single block as a single line of data.  Regardless 
of the format of the original, when pasted into an 
emulation, text editor, or other application, the data 
appears as a single line.
Copy by Line
If this mode is selected, all copy actions will copy each 
line within  the screen or the selected area and add a  
CR (carriage return) character at the end of each line 
of the original.  When pasted into an emulation, the 
CR has an  impact  only if you Paste Tab or Paste 
Field Exit.  When pasted into a text editor or other 
application, each CR causes a new line.

3. Using the pointer, select the text to be copied.
4. To copy the selected text, you can:

• Click the copy icon in the toolbar.
• Select Copy from the Edit menu.
• Right-click and select Copy.

NOTE:  If you are continuing to use the previously selected copy or 
paste mode, skip steps 1 and 2.  The current copy mode appears in 
the right-click menu within parentheses.

To paste:
1. From the Edit menu, point to Paste mode.
2. Select a paste mode.

Paste Continuous
If this mode is selected, pasting takes all text on the 
clipboard and enters it at the cursor location as a 
single, continuous line.  The cursor remains in the 
same input field, at the end of the paste.
Paste Tab
If this mode is selected, pasting takes each line of text 
on the clipboard,  enters it at the cursor location, and 
adds a tab.  The tab causes the next line to be pasted 
into the following input field.  Following the paste, the 
cursor is already positioned in the next input field.  
This mode is particularly useful when combined with 
Copy by Line.
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Paste Field Exit
If this mode is selected, pasting takes each line of text 
on the clipboard,  enters it at the cursor location, 
deletes any remaining text that follows the new line of 
text, and adds a tab.  The tab causes the next line to 
be pasted into the following input field and the 
remaining text in that field is also deleted.  Following 
the paste, the cursor is already positioned in the next 
input field.  This mode is particularly useful when 
combined with Copy by Line and pasting into fields 
with text that must otherwise be manually deleted.

3. Insert the cursor where the paste is to begin.
4. To paste the selected text, you can:

• Click the paste icon in the toolbar.
• Select Paste from the Edit menu.
• Right-click and select Paste. 

NOTE:  If the content that is pasted from the clipboard fills all the 
screen’s input fields, pasting begins again from the screen’s first 
input field and overwrites the current content of the fields.

Viewing Images

Use the Picture command on the View menu to enable 
BOSâNOVA Web to search the server images directory to 
locate an image file whose name matches a word you 
have selected. 

NOTE:  The selected word must be delimited by spaces.   
BOSâNOVA Web appends the image file extension (for example, 
.jpg) to the word and searches for this file on the server.

There are two ways to use the Picture command:
1. From the emulation View menu, select Picture:
2. On the display session screen, locate the word that 

will serve as the name of the image file BOSâNOVA 
Web will search for.

3. Position the cursor on one letter of the word.
4. Select View > Picture.  
If an image  file with the specified name exists, the file 
opens in a new, top level browser window.
Right-clicking a word on the display screen:
1. On the display session screen, right-click the word 

that is the name of the image file BOSâNOVA Web will 
search for.

2. Select Picture on the menu that appears.
If an image file with the specified name exists, the file 
opens immediately in a new, top level browser window.
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Viewing Full-screen Mode

To work in full-screen mode—that is, without the emula-
tion menus, toolbar, and task bar— select one of the fol-
lowing:
• From the emulation View menu, select Full Screen.
• Right-click and select Full Screen. 

NOTE:  To return to the emulation view, right-click and clear Full 
Screen.

Customizing the Display 
Emulation

This section documents the various ways you can cus-
tomize the appearance of your display sessions.

The Emulation Toolbar

The emulation toolbar contains buttons for activating 
common tasks such as Copy, Paste, Save, New Session, 
etc.  You can add or remove buttons, or change button 
order within the toolbar, by using the Toolbar Customiza-
tion dialog box.

Customizing the Toolbar 

To customize the emulation toolbar, select one of the fol-
lowing:
1. To open the Toolbar Customization dialog box:

• From the emulation Options menu, select Toolbar 
Customization.

• Press CTRL + L on the keyboard.
• Right-click, point to Options, and select Toolbar 

Customization.
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2. From the Available toolbar buttons dropdown list, 
select a “family” of toolbar buttons to customize.
The available button “families” are:
General
Represents the BOS display emulation add-on 
functions.
Host Operations
Represents some of the iSeries actions and 
commands.
Function Keys
Represents the iSeries function keys, for example, F3.

Personal Macros
Represents the macros built by you for your personal 
needs.
In addition, the names of the host command groups 
assigned to the user appear in this list.

Adding a Button to the Emulation Toolbar
1. Select a “family” of buttons from the Available toolbar 

buttons dropdown list.
2. Select the button to add to the emulation toolbar.
3. Click Add.  You have now added the selected button 

to the emulation toolbar.

Changing the Location of a Button
1. Select the button from the Current toolbar buttons list.
2. Click Move Up or Move Down to change the order of 

the button in the toolbar.

Removing a Button
1. Select the button to remove.
2. Click Remove. The button no longer appears in the 

emulation toolbar.

Miscellaneous
• Disabling the ToolTips: Clear the Show ToolTips 

option.
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• To return to the previous saved values: Click 
Reset.

Click OK to save any changes and to close the Toolbar 
Customization dialog box.

Showing or Hiding the Toolbar

To hide the toolbar, select one of the following:
• From the emulation View menu, deselect Toolbar.
• Right-click and deselect Toolbar.
To show the toolbar, select one of the following:
• From the emulation View menu, select Toolbar.
• Right-click and select Toolbar.

Display Attributes

With this option you can determine how your iSeries dis-
play will look.  You can change the display attributes of 
any display session assigned to you.  Note that this option 
applies to the green screen sessions only.

Display Color Attributes

To change the display attributes of a display session, 
select one of the following:
• From the emulation Options menu, select Display.

• Press CTRL + D on the keyboard.
• Right-click, point to Options, and select Display.
The Display Properties dialog box opens.

              

1. From the Properties of dropdown list, select the dis-
play session whose attributes you are changing.

2. For each field attribute (selected from the Field 
attributes dropdown list), preview your selection and 
    
Previous Page Contents 32 Index Next Page



BOSâNOVA Web User Guide
select the best option for you. Set the following 
options as needed:
a. Click BackColor to change the attribute’s 

background color.  A color pallet opens. When you 
select the background color, the color pallet is 
automatically closed.

b. Click ForeColor to change the attribute’s 
foreground color. A color pallet opens. When you 
select the foreground color, the color pallet is 
automatically closed.

c. Select Blink to set a blinking attribute.
d. Select Underline to underline the selected 

attributes.
e. Select Column separators to use a separator 

with this attribute.
3. Click Apply to save any changes and keep the dialog 

box open. Click OK to save the changes and close the 
Display Properties dialog box. 

NOTE:  Click Defaults to restore the defaults of the display 
attributes.

You can also change the display color attributes by using 
the right-click menu:
1. Right-click and select Color Attributes.
2. You can:

a. Select BackColor to change the attribute’s 
background color. A color pallet opens. When you 
select the background color, the color pallet is 
automatically closed.

b. Select ForeColor to change the attribute’s 
foreground color. A color pallet opens. When you 
select the foreground color, the color pallet is 
automatically closed.

c. Select Blink to set a blinking attribute.
d. Select Underline to underline the selected 

attributes.
e. Select Column separators to use a separator 

with this attribute.

Exporting Display Properties

NOTE:   The Work as Administrator checkbox is available only to 
users with Administrator privileges.    The Export Properties and 
Background Image tools are only available to users with 
Administrator privileges

Select Work as Administrator to save the display prop-
erties as a global configuration to be applied to all users. 
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When this option is not selected, the saved display prop-
erties are only available to the user that saved them. How-
ever, when selected, the global display properties are 
applied to every user except for users that have defined 
private display properties for that display session. 
When a display session is started, BOSâNOVA Web tries 
to apply display properties in the following order: 

a. The user's private display property definitions. If 
any exist, these will be applied. 

b. If there are no private display property definitions, 
the global display property attributes defined by 
the Administrator. If any exist, these will be 
applied. 

c. If neither private nor global definitions exist, the 
default factory settings are applied. 

The Export Display Properties dialog box is an Adminis-
trator tool.  Using Export Display Properties, an Adminis-
trator can copy one global display property definition into 
another global definition.

NOTE:  A user with Administrator privileges that is not working as 
an Administrator, cannot save global display property settings. If the 
settings are saved while Work as Administrator  is clear, the 
profile will not appear in the Export Display Properties dialog box's 
Select profile to export pane.

To export any display properties:
1. Select the Work as Administrator option.
2. Click the Export Properties button. The Export Dis-

play Properties dialog box opens.
              

3. From the left pane, select a profile to export.
4. From the right pane, select the target profile that will 

be overwritten.
5. Click Export to overwrite the target profile.
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Inserting or Changing the Background Image  

NOTE:  The Work as Administrator checkbox is available only to 
users with Administrator privileges.  The Export Properties and 
Background Image tools are only available to users with 
Administrator privileges.

Select Work as Administrator to save the display prop-
erties as a global configuration to be applied to all users. 
When this option is not selected, the saved display prop-
erties are only available to the user that saved them. How-
ever, when selected, the global display properties are 
applied to every user except for users that have defined 
private display properties for that display session. 
When a display session is started, BOSâNOVA Web tries 
to apply display properties in the following order: 

a. The user's private display property definitions. If 
any exist, these will be applied. 

b. If there are no private display property definitions, 
the global display property attributes defined by 
the Administrator. If any exist, these will be 
applied. 

c. If neither private nor global definitions exist, the 
default factory settings are applied.

NOTE:  A user with Administrator privileges that is not working as 
an Administrator, cannot save global display property settings. 

To insert or change a background image:
1. On the Display Properties dialog box, select the Work 

as Administrator checkbox.
2. Click Background Image.  The Background Image 

Settings dialog box appears.
              

3. Select the Show background Image checkbox to 
insert a background image. 

NOTE:  If the Show background image checkbox is clear, the 
background will be the color previously chosen from the BackColor 
palette.  If no background color is chosen the default color will be 
displayed.

4. From the Image File box, select either:
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• BOSâNOVA Web Server Images
This lists previously defined images available for 
use as a background image.

• Import From PC
Select this to download a picture from your PC to 
be used for the background image. 

NOTE:  The maximum file size for this picture is approximately 
32k.

5. From the lower panel, select either: 
a. Stretch image to screen size
b.  Tile inserts the picture repeatedly in rows and 

columns to fill up the screen.
c. Locate at allows you to insert a picture that is 

smaller than the screen and place it by specifying 
the location of the top left corner using the row and 
column boxes.          

6. Click OK.
7. Click OK. 
While customizing the scheme, click Apply to preview the 
results in the current emulation session.

Keyboard Customization 

With this option you can:
• Map (assign) any iSeries command to any keyboard 

key or to any combination of keyboard keys.
• Create a new mapping or import a default keyboard 

mapping.
To map/customize your keyboard, select one of the fol-
lowing:
• From the emulation Options menu, select Keyboard 

Mapping.
• Press CTRL + K on the keyboard.
• Right-click, point to Options, and select Keyboard 

Mapping.
The Keyboard Mapping dialog box opens.
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NOTE:  By default, the left Control key is mapped to Perform Error 
Reset and the right Control key is mapped to Perform Field Exit.

Viewing a Keyboard Mapping 

To view the current mapping of a keyboard key, select the 
keyboard key (left click).
The selected Keyboard Key is displayed in the PC keys 
column in the top panel. The Categories column shows to 
what type of function the key is currently mapped. The 
Characters column shows to which particular command, 
function, symbol, or character the key is currently 
mapped.
The Categories Column contains the following groups:

Host Operations
Includes common host actions (Attn, Clear, Field+, etc.).
Host Function Keys
Includes common host command keys (Cmd1, etc.).
Emulation Controls
Includes common emulation actions (Jump to next host 
session, Play macro, etc.).
Characters
Includes all the keys for letters, numbers, and symbols.
Numeric Keypad Keys
Includes the numbers on the numeric keypad.

Creating or Editing a Keyboard Mapping

To create a new keyboard key map or change the current 
mapping of a keyboard key, use the right mouse button:
1. Right-click the keyboard key.  The following cascading 

menu is displayed:
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2. If you want to use a PC key combination, select Shift, 
Ctrl, or Alt.  Select Normal to map the key’s face 
value.

3. Point to Map To and select a group from the cas-
cading menu  (the contents of each group is described 
in “Viewing a Keyboard Mapping” on page 37).

4. Select the new desired keyboard assignment from 
cascading menus and click OK.

Removing a Keyboard Mapping

To completely remove a currently assigned keyboard key 
map, use the right mouse button:
1. Right-click the keyboard key.
2. If you want to delete a keyboard key map with a PC 

key combination, select Shift, Ctrl, or Alt. Select 
Normal to delete the key’s face value map.

3. Select Delete from the cascading menu.

The Emulation Ruler

If the System Administrator has enabled Ruler in the dis-
play session profile properties, the display session can be 
customized to include a ruler.  
Use the Ruler command on the View menu to hide the 
display ruler and to change the way the display session 

ruler appears.  If the ruler icon has been added to the 
toolbar, the ruler can also be controlled from the toolbar.

NOTE:  The ruler is not displayed when MorphMaster is running.  If 
MorphMaster is running and View > Ruler is selected, the display 
session automatically switches to a green screen.

Ruler options include:
None
The ruler is hidden.
Horizontal
Only a horizontal ruler is displayed.
Vertical
Only a vertical ruler is displayed.
Horizontal and Vertical
Both rulers are displayed.
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Working with Macros

With the Macro Organizer you can: 
• Play a macro, p. 40
• Add a new macro, p. 40
• View macro commands, p. 41
• Edit a macro, p. 41
• Rename a macro, p. 42
• Delete a macro, p. 42
• Export/Import macros, p. 42

Opening the Macro Organizer

To open the Macro Organizer, select one of the following 
options:
• From the emulation Macro menu, select Macro Orga-

nizer.
• Press CTRL + M on the keyboard.

The Macro Organizer screen opens, where all macros 
assigned to you are displayed in a Windows-like tree 
structure:

NOTE:  The Macro Organizer functions are enabled depending on 
the permissions assigned to you by your BOSâNOVA Web 
administrator.
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Playing a Macro

To run an existing macro, select one of the following:

From the Macro Organizer

1. Open the Macro Organizer (see p. 39).
2. Select a macro from the macros list.
3. Click Play. The macro is launched.

From the Display Emulation

Select one of the following options:
• Right-click, point to Macro, select Play Macro, and 

select from the cascading menu the macro you want 
to play.

• Click the toolbar button for the macro to run.
• From the Macro menu, point to Play Macro, and 

select a macro to run.
An example of the macros list is shown below.

                

Recording a New Macro

To record a new macro from the emulation:
1. Select one of the following options:

• Click the Record Macro icon on the emulation 
toolbar.

• Right-click, point to Macro, and select Record 
Macro.

• From the Macro menu, select Record Macro.
2. Enter or select any action to be recorded.
3. Click Stop to finish recording.  Select Pause to tem-

porarily stop the recording process. To resume 
recording, deselect Pause.

4. Enter a unique logical name for the new macro and 
click OK.

Adding a New Macro

To record a new macro:
1. Open the Macro Organizer (see p. 39).
2. Click Add. The new macro dialog box opens.
3. Enter a unique logical name for the new macro.
4. Click OK. The Macro Editor opens.
5. Continue with the Editing a Macro procedure, p. 41.
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6. Click OK to save the changes. The new macro 
appears at the end of the Personal Macros list.

Viewing a Macro

To view the macro commands:
1. Open the Macro Organizer (see p. 39).
2. Select a macro from the list.
3. Click View.  The Macro Viewer opens.  You can view 

all the macro commands and codes, but you cannot 
change any commands.

4. Click Close to return to the Macro Organizer.
5. Click OK to close the Macro Organizer.

Editing a Macro

To change commands in a Personal macro (note that you 
can’t change any Common or Group macros):
1. Open the Macro Organizer (see p. 39).
2. Expand the Personal Macros tree and select a macro.  

Edit is enabled.
3. Click Edit. The Macro Editor opens.

              

4. Select the command or string to change.
• To delete: Right-click and select Remove.
• To replace: Right-click, point to Replace with, and 

select a new command to replace the current 
command.

• To add: Right-click, point to Add, and select a 
command from one of the options after the last 
command or string.

• To insert: Right-click, point to Insert, and select a 
new command from one of the options to insert 
after the selected command or string.

5. Click OK to save any macro changes and to return to 
the Macro Organizer.
    
Previous Page Contents 41 Index Next Page



BOSâNOVA Web User Guide
6. Click OK to close the Macro Organizer.

Renaming a Macro

To change the name of an existing Personal macro (note 
that you can’t change any Common or Group macro’s 
name):
1. Open the Macro Organizer (see p. 39).
2. Select a macro from the Windows-like macros list.
3. Click Rename. The Rename Macro dialog box opens.
4. Enter a new name for the macro.
5. Click OK to save the name and return to the Macro 

Organizer. The macro with the new name appears in 
the list.

Deleting a Macro

To completely remove a Personal macro (note that you 
can’t remove any Common or Group macros):
1. Open the Macro Organizer (see p. 39).
2. Select a macro from the Windows-like macros list.
3. Click Remove. The following message appear:

              

4. Click Yes. The Macro Organizer re-opens. The 
removed macro is no longer in the list.

Exporting and Importing Macros

1. Open the Macro Organizer (see p. 39).
2. Click Export/Import.  The Export/Import Macros 

dialog box opens.
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3. To export a macro to a group:
a. Select the macro to export from the Personal 

macros list.
b. Select the group from the Groups dropdown list.
c. Click Export. The macro appears in the group’s 

macro list.
d. Click OK to save the changes and return to the 

Macro Organizer.
4. To import a macro from a group:

a. Select a group from the Groups dropdown list.
b. Select the macro to import from the Group macros 

list.
c. Click Import. The macro appears in the Personal 

macros list.
d. Click OK to save the changes and return to the 

Macro Organizer.
5. Click OK to close the Macro Organizer.
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MorphMaster This section includes:
• An overview of MorphMaster, p. 45.
• Excluding elements from conversion, p. 46.
• An overview of MorphMaster customization, p. 47.
• Customizing using the Style folder, p. 50.
• Customizing using the Rule base, p. 55.
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An Overview of MorphMaster

MorphMaster is a real-time tool that analyzes IBM legacy 
screens and instantly converts them to full-color, mouse-
sensitive screens complete with panels, popup windows, 
buttons, and other standard graphic user interface fea-
tures.  Without altering the underlying legacy screens, you 
can change the look of your MorphMaster screens as 
often as you want; changes take effect immediately.  You 
can also exclude MorphMaster elements from being “mor-
phed,” giving you complete control over the screen’s 
appearance.
MorphMaster enables BOSâNOVA Web system adminis-
trators to maintain and modify site-wide applications and 
prevent custom-designed MorphMaster screens from 
being modified by individual users.
With MorphMaster, there is no need to maintain dual 
screen sets because the conversion from host screen to 
morphed screen is dynamic.  Any change in the host 
screen is automatically visible in the MorphMaster screen.  
Style changes in MorphMaster, however, do not change 
the underlying host screen.

Selecting and Deselecting MorphMaster Dis-
play

To select MorphMaster display mode:

• On the emulation toolbar, click .
• From the emulation View menu, select 

MorphMaster.
• Right-click and select MorphMaster.

To deselect MorphMaster display mode:

• On the emulation toolbar, click .
• From the emulation View menu, deselect 

MorphMaster.
• Right-click and deselect MorphMaster.
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Excluding Elements from 
Conversion

Use the Exclude dialog box to determine which Mor-
phMaster elements will not be applied to a specific host 
screen.

NOTE:  Exclusions defined in the Exclude dialog box are different 
than exclusions defined in a Rule base (see p. 55).  Exclusions 
defined in the Exclude dialog box prevent MorphMaster from 
converting elements in the open screen only. 

1. From the emulation Options menu, select Exclude.  
The Exclude dialog box opens. 

               

2. Select one or more checkboxes; these indicate the 
MorphMaster elements that MorphMaster will not 
create in the active screen.  If you reopen the Exclude 
dialog box when the same screen is active, these 
checkboxes are displayed as selected.

3. If you want these selections to appear each time you 
open the Exclude dialog box—that is, for screens that 
have never had any Exclude options assigned to 
them—click Set as Default.  If you do not click Set as 
Default, the next time you open the Exclude dialog 
box—that is, for screens that have never had any 
Exclude options assigned to them—all the check-
boxes will be clear.

4. Click OK.  The changes are applied immediately.
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Customizing MorphMaster

Use the MorphMaster Customization dialog box to build a 
Rule base that directs MorphMaster’s identification of 
screen elements and to customize Styles that define the 
appearance of the MorphMaster screen.  You can cus-
tomize most elements on the host screen including fonts, 
colors, buttons, panels, titles, and more.
To open the MorphMaster Customization dialog box, from 
the emulation Options menu, select MorphMaster Cus-
tomization.

              

As pictured above, the MorphMaster Customization dialog 
box has four panels:
Elements Panel
Lists the potential components of a “morphed” screen.
Navigation Panel
Buttons enable easy navigation through the elements 
panel.
Glossary Panel
Displays a definition, procedural hints, or a preview of the 
style.
Configuration Panel
Contains buttons and fields for defining settings.

An Overview of MorphMaster Customization

The Elements Panel of the MorphMaster Customization 
dialog box uses a “tree” structure.
• If an item has a plus sign (+) next to it, it contains 

nested items.  Click it to expand the item and display 
the nested content.  

• If an item has a minus sign (-) next to it, it is already 
fully expanded.  Click it to collapse that part of the 
tree. Navigation Panel

Elements Panel

Glossary Panel

Configuration Panel
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When you select an element in the Elements Panel, but-
tons and fields for  configuring that element set appear in 
the Configuration Panel.
Pictured below is the Elements Panel of the MorphMaster 
Customization dialog box.

              

There are ten categories of elements.  Each category con-
tains one or both of the following folders:
• Style:

Use Style to define the appearance of the MorphMas-
ter screen.  You can customize fonts, colors,  and the 
optional use of color translation, panels, and button 
numbers.

• Rule base:
Use the Rule Base to enter instructions for MorphMas-
ter that direct its  identification of graphic screen ele-
ments.

NOTE:  For an illustration of each category, see Figure # 2.
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Figure 2: Elements of a Screen that MorphMaster can Customize

              

Also note the subfile option panel, the input field panel, and the function key panel.

Title

Subfile Options

Show Number

Subfile Data

Plain Text

Function Keys

Plain Text

Subfile Header

Edit Fields

Input Field
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Customizing from the Style Folder

Use the Style folder content to 
define the appearance of your Mor-
phMaster screen.  The contents of 
the Style folder will include some or 
all of the following:

• Font, see p. 52.
• Font color, see p. 52.
• Background color, see p. 52.
• Show number, p. 53.
• Message line, p. 53.
• Design, p. 53.
• Grouping range, 54
• Color translation, see the following section.

The Subfile Style folder is discussed on page p. 54.  

Customizing a Color Translation Table

A host screen text may be displayed with any of 32 
attributes including colors, underscore, and blinking.  Nor-
mally, MorphMaster ignores the attributes and displays 
the host screen element using the color defined in Style.  
However, using a Color Translation table, MorphMaster 
can be configured to display input fields, output fields, 
titles, and subfiles in a color different than that defined in 
Style and that maintains the original text attributes.
In the first column of the Color Translation table, 32 host 
screen text attributes are listed.  You define the Mor-
phMaster colors that replace one or more of the original 
host assigned attributes; this is a Color Translation table.  
Next, in the Input, Plain text, Menus, Function keys, or 
Subfile Style folder, you apply the table.  In this way,  you 
link the Color Translation table to the MorphMaster ele-
ment.
Color translation is especially useful when working with 
applications that use different colors to highlight specific 
data. 
There are three steps to creating a customized Color 
Translation table:
1. Open and name a new Color Translation table.
2. Define the text color of one or more host screen ele-

ments.
3. Define the background color of one or more host 

screen elements.
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To open and name a new Color Translation table:
1. Expand both the General folder and its Style folder.
2. Select Color translation table.
3. From the lower panel, click Add.  The Host screen 

attribute translation table dialog box opens.
4. Enter a name for the Color Translation table in the 

Table name field.
5. In the lower panel, from the first column of the table, 

double-click a host screen attribute.  The Color table 
settings dialog box opens.

To define the color of the text:
6. Select both Translate and Text Foreground.
7. Select a color from the palette, or click More colors to 

customize a color.  (If you’ve customized a color, click 
OK to close the Custom Color dialog box.)

To define the color of the background:
8. Ensure that the Transparent checkbox is clear.

NOTES about Transparent:

To make the background color of the elements Plain text and Titles 
the same color as the background screen or panel color, select 
Transparent.  If you select Transparent, you cannot define a 
background color.

Only the background of the elements Plain text and Titles becomes 
Transparent.  If, in a Color Translation table, any other element is 
assigned Transparent, it will take the background color assigned to 
it in its Style folder.

When background color is used, MorphMaster performs the color 
translation every time the attribute exists.   If there is no text in the 
field, the result is an empty screen of the color you defined as the 
background color.

9. Select Text Background.  (Ensure that Translate is 
still selected.)

10. Select a color from the palette, or click More colors to 
customize a color.  (If you’ve customized a color, click 
OK to close the Custom Color dialog box.)

11. If necessary, select additional host screen attributes 
and repeat steps 6 –10.

12. Click Apply to preview the change, OK to approve the 
change and close the dialog box, or Cancel to reject 
the change and close the dialog box.      
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Customizing the Font      

Note on Font Resizing!
MorphMaster evaluates the space available on a screen and 
determines whether or not, using the assigned settings, the content 
will fit.  If the content will not fit on the screen, MorphMaster 
automatically resizes the font.  In some instances, this is why a 
screen does not appear exactly as customized.  

To customize a font, use one or both of the following Style 
files:

• Font:  to customize type face, style, and point 
size.

• Font color: to customize the color of the text. 

To customize type face, style, and point size:
1. Expand both the Element folder and its Style folder.
2. From the Elements panel, click Font.
3. From the lower panel, use the three dropdown menus 

to customize the font, its style, and its size.
4. For the elements Plain text and Titles only:

Select Transparent to make the attribute’s back-
ground color the same as the background screen 
color.

5. Click Apply to preview the change, OK to approve the 
change and close the dialog box, or Cancel to reject 
the change and close the dialog box.

To customize the color of the text:
1. Expand both the Element folder and its Style folder.
2. From the Elements panel, click Font color.
3. From the lower panel, select a color from the palette 

or click More to customize a color.  (If you’ve custom-
ized a color, click OK to close the Custom Color dialog 
box.)

4. Click Apply to preview the change, OK to approve the 
change and close the dialog box, or Cancel to reject 
the change and close the dialog box.

Customizing the Background Color    

NOTE:  customize the background color of the entire display 
screen, as opposed to the background color of a specific element, 
select General > Style > Background color.  Then, follow steps 3 
and 4 below.    

1. Expand both the Element folder and its Style folder.
2. From the Elements panel, click Background color.
3. From the lower panel, select a color from the palette 

or click More to customize a color.  (If you’ve custom-
ized a color, click OK to close the Custom Color dialog 
box.)

4. Click Apply to preview the change, OK to approve the 
change and close the dialog box, or Cancel to reject 
the change and close the dialog box.
    
Previous Page Contents 52 Index Next Page



BOSâNOVA Web User Guide
Customizing Color Translation

1. Expand both the Element folder and its Style folder.
2. From the Elements panel, click Color translation.  

For information about Color Translation tables, see 
p. 50.

3. From the Color table menu in the lower panel, select 
a color table.

4. Click Apply to preview the change, OK to approve the 
change and close the dialog box, or Cancel to reject 
the change and close the dialog box.

Customizing Show Number

Menus, function keys, and subfile options have action 
numbers associated with them.  You can define Mor-
phMaster to omit or display the number during conver-
sion.
1. Expand both the element’s folder and its Style folder.
2. From the Elements panel, click Show number.
3. From the lower pane, select or clear the Show 

number checkbox.
4. Click Apply to preview the change, OK to approve the 

change and close the dialog box, or Cancel to reject 
the change and close the dialog box.

Customizing the Message Line

Warnings, confirmations, and other iSeries messages 
appear on the bottom line of the screen.  To customize the 
appearance of these messages:
1. Expand both the General folder and its Style folder.
2. From the Elements panel, click Message line.
3. To customize the font attributes, click Font.  Then, 

from the Configuration panel, use the three dropdown 
menus to customize the font, its style, and its size.

4. To customize the font’s colors, click Color.  Then, from 
the Configuration panel, select a color from the palette 
or click More to customize a color.  (If you’ve custom-
ized a color, click OK to close the Custom Color dialog 
box.)

5. Click Apply to preview the change, OK to approve the 
change and close the dialog box, or Cancel to reject 
the change and close the dialog box.

Customizing the Design

Menus, function keys, and subfile options can be dis-
played as either 3D buttons or hyperlinks.  To customize 
the Design:
1. Expand both the element’s folder and its Style folder.
2. From the Elements panel, click Design.
3. Choose from one of the two options:
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• 3D button:
Each element appears as a button.  Click 
Customize style to define whether or not the 
button will change its appearance when the mouse 
pointer is placed on it.

• Hyperlink:
The text of each element changes when the 
mouse pointer is placed on it.  Click Customize 
style to begin the Hyperlink Style Wizard.  
Instructions regarding the Hyperlink Style Wizard 
appear on the wizard’s screens.

4. Click Apply to preview the change, OK to approve the 
change and close the dialog box, or Cancel to reject 
the change and close the dialog box.

Grouping Range

Buttons located within a defined range of rows can be 
configured to appear on a panel.  To define the range:
1. Expand the Function keys folder and its Style folder.
2. From the Elements panel, click Grouping Range.
3. Enter the row range to which grouping will be applied.  

Host screen elements outside the specified range will 
not be grouped.

Customizing the Subfile Style Folder

1. Expand both the Subfile 
folder and its Style folder.  

2. Select one of the six 
entries ending with the 
word color.

3. From the lower panel, 
select a color from the 
palette or click More to 
customize a color.  (If you’ve customized a color, click 
OK to close the Custom Color dialog box.)

4. Click Apply to preview the change, OK to approve the 
change and close the dialog box, or Cancel to reject 
the change and close the dialog box.

Note on Subfile Font!
Because subfile text alignment is important, we recommend that 
you use a fixed-width font—where each character is the same 
width—such as Courier.  Unlike proportionally-spaced fonts, fixed-
width fonts ensure that each character takes up the same amount of 
space on the screen.  IBM legacy screens use fixed-width fonts; if 
MorphMaster also uses fixed-width fonts, it can maintain host 
screen proportions between field and value sizes. 
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Customizing the Rule Base

The Rule base is a set of rules that MorphMaster uses to 
analyze the host screen.  Use the contents of each Rule 
base folder to modify these rules and, thereby, change the 
way MorphMaster interprets the host screen.  
MorphMaster is a real-time tool whose analysis of the 
host screen depends heavily on the host screen’s appear-
ance.  Host applications vary greatly in their screen for-
mats and design conventions.  One application may use 
Command keys (<CMD3=Exit>, for example) to list func-
tion keys, while another may use Function keys 
(<F3=Exit>, for example).  Some applications may use 
single-column menus while, in others, menus have two or 
even three columns.  In some host applications, popup 
windows are enclosed by a colored frame; in others, they 
are enclosed by a frame of repeated characters.
MorphMaster’s default Rule base settings are compatible 
with most common host screen design principles.  How-
ever, if your host application contains unusual screen for-
mats, you may have to modify the Rule base definitions to 
improve MorphMaster’s analysis.  We recommend that 
you run MorphMaster with the default Rule base settings 
and modify them only when you see that MorphMaster 
has misinterpreted the host screen.
Changes in the Rule base go into effect immediately and 
are visible as soon as the MorphMaster screen updates.

The following elements have Rule base folders that can 
be customized:

• General, see p. 56.
• Menus, see p. 56.
• Function keys, see p. 58. 
• Subfile, see p. 60.
• Subfile options, see p. 62.
• Titles, see p. 63.
• Panels, see p. 64.
• Popup windows, see p. 64.
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General Rule Base 

Use the General Rule base to define groups of screens 
which will not be converted by MorphMaster, to instruct 
MorphMaster not to create panels, and to determine how 
MorphMaster arranges the elements on the user inter-
face.

NOTE:  Unlike the Exclude feature (see p. 46), which is used to 
determine which  elements of individual screens will not be 
affected by MorphMaster, this definition enables you to display 
groups of full screens in Excluded mode: all screens containing 
the string in the specified range are excluded.

1. Expand General > Rule base.
2. Select Screen inhibitors.

a. From the bottom panel, click Add.
b. Enter a string and a From line / To line range. 
When the string is present in the specified location, 
MorphMaster mode is not available.

3. Select or clear the Block panels analysis checkbox.  
When selected, MorphMaster does not create panels.

4. Select an Arrange  elements option.
Font size
Select the attributes of the font from the three lists in 
the Configuration Panel.  MorphMaster arranges the 
elements based on the font’s attributes. 

Window size
MorphMaster arranges the elements according to the 
size of the session window.

NOTE:  If you have a layout problem, try assigning font attributes 
that are identical to the attributes of the output font.

Menus Rule Base

MorphMaster recognizes a menu by identifying the pre-
fixes and suffixes beside menu numbers and by identi-
fying delimiters.  
• A prefix is the character that precedes the menu entry 

number. 
• A suffix is the character that separates the menu num-

ber from the menu text (for example, a period, blank, 
or hyphen).

• A delimiter is the space that follows the menu text.
In the example  *5. Work with line status  the 
prefix is an asterisk, the suffix is a period, and the delim-
iter is the empty space following the word status.
To configure MorphMaster to identify menus:
1. Expand Menus > Rule base.
2. Select Number prefixes and suffixes.
3. From the bottom panel, click Add.
4. Enter a prefix, a suffix, or both.
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In menus that contain more than a single column, it is 
better to define how MorphMaster recognizes the end of 
menu items.  This configuration also helps when plain text 
follows the menu text on the same line.
To define how MorphMaster recognizes the end of menu 
items:
1. Expand Menus > Rule base.
2. Select an option.

Delimited by display attributes
If this option is used, the end of a menu item is set by 
the presence of any display attribute (between Hex 20 
and 3F).
Delimited by spaces
Select the checkbox and enter a figure between 2 and 
20.  If this option is selected, the specified number of 
spaces (following menu text) marks the boundary of a 
menu item.  For example, if minimum number of 
spaces is set to 5, MorphMaster will interpret the first 
occurrence of five successive spaces as the end of 
the menu text.

NOTE:  If you select both, MorphMaster will recognize the end of a 
menu item either by a display attribute or the specified minimum 
number of spaces, whichever comes first.

To configure MorphMaster to recognize uppercase letters 
as menu numbers:
1. Expand Menus > Rule base.
2. Select Number format.
3. From the bottom panel, select Allow uppercase let-

ters.
4. In the Number of letters field, select either 1, 2, or 3.

You can determine the range allowed for menu numbers.  
Numbers outside of this range will not be recognized as 
menu numbers.
To determine the range allowed for menu numbers:
1. Expand Menus > Rule base.
2. Select Menu numbers range.
3. From the bottom panel, enter a line range.  Numbers 

outside of that range will not be converted to a menu.

To determine the number of spaces between a menu 
number, or its suffix, and the menu text:
1. Expand Menus > Rule base.
2. Select Maximum number of spaces.
3. In the bottom panel, enter a figure in the Maximum 

number of spaces field.
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There may be certain conditions when a screen contains 
aligned text that looks like a menu, but isn't.  To prevent 
MorphMaster from attempting to convert this text into a 
menu, specify disqualification strings.  These are strings 
that, when present, prevent MorphMaster from converting 
these screen areas (which otherwise would qualify as 
menus) into menus.
To define disqualification strings:
1. Expand Menus > Rule base.
2. Select an option.

Menu level disqualifier
Click Add and enter the string.  If host menu-like text 
contains this string, it will not be converted into a 
MorphMaster menu.  Note that if one menu is 
“eliminated,” there may still be another list on the 
same legacy screen that can qualify as a menu.
Screen level disqualifier
Click Add, enter the string and the range.  If a screen 
contains this string within the defined area, no menu 
will be created anywhere on the screen.

You can specify the area on the screen within which Mor-
phMaster will look for host text that can be converted to 
menus.  If host text appears outside that range, it will not 
be converted to a menu.

To configure a search area:
1. Expand Menus > Rule base > Line search range.
2. Select an option.  (A popup window is a smaller 

window that opens on top of full window.  See p. 64.)
Full window
Enter a range.  If a host menu appears outside that 
range, it will not be converted to a menu.
Popup window
Enter a range.  Ensure that the entries are relative to 
the line-numbering of the popup window—the frame of 
the popup window is line #1—and not to the line-
numbering of the original green screen.  If a host 
menu appears outside that range, it will not be 
converted to a menu.

Function Keys Rule Base

MorphMaster recognizes Function keys by identifying the 
prefix and suffix.  Prefix and suffix combinations that 
accompany the standard function keys, F1–F24, are con-
figured as default settings.  
Each prefix and suffix combination forms a separate unit 
and requires a separate entry.  At runtime, MorphMaster 
searches the listings in the order of their appearance. We 
recommend that you list the more commonly used entries 
first to optimize MorphMaster performance.
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In addition, you can define an Action buttons for any text 
on the screen that you want to see as a button and not as 
plain text.   
To add a Function key prefix/suffix combination:
1. Expand Function keys > Rule base.
2. Select Function key and click Add.
3. Enter a prefix and suffix.

Prefix
Add additional strings that reflect the common usage 
in your environment.  This defines prefix strings for 
standard function keys (1-24).  MorphMaster will only 
recognize a screen element as a function key if it 
contains a number (1-24) preceded by one of the 
defined strings.  
Suffix
Add additional strings that reflect the common usage 
in your environment.  The suffix is a string of one or 
more characters that separates the identifier from its 
explanation.  The suffix does not appear as part of the 
button text at runtime.

To add an Action button:
1. Expand Function keys > Rule base.
2. Select Action buttons and click Add.
3. Complete the three fields:

On screen text
Enter the string that MorphMaster will convert into a 
button.
Host command
Enter the command to be performed when the button 
is pushed.
Suffix
Enter a character that separates between 
identification data and button description.

To insert a picture as an Action button:
1. Select the Show Picture checkbox.
2. Click Picture.  The Image Settings dialog box 

appears.
3. Select an option. 

• BOSâNOVA Web Server Images
This is a list of previously defined images. 

• Import From PC 
Click to download a picture from a PC to be used 
for the background image.

NOTE:  The maximum file size for this picture is approximately 
32k.  
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To remove an Action button:
1. Expand Function keys > Rule base.
2. Select Action buttons.
3. Select an Action buttons.
4. Click Remove.

Separators

Separators create a visual break between multiple func-
tion keys and between multiple buttons.  The default sep-
arator is two spaces.  However, you can define other 
characters to be separators (for example, a comma).
Example 1: The separator between the two function keys 
is two spaces.

F1=Help  F3=Exit

Example 2: The separator between the two function keys 
is a comma.  No spaces are used.

F1=Help,F3=Exit

To add a separator:
1. Expand Function keys > Rule base.
2. Select Separators and click Add.
3. Enter the new separator in the field in the lower panel.

You can specify the area on the screen within which Mor-
phMaster will look for host screen elements that can be 

converted to function keys.  If host text appears outside 
that range, it will not be converted to a function key.
To configure a search area:
1. Expand Function key > Rule base > Line search 

range.
2. Select an option.

Full window
Enter a range.  If host text appears outside that range, 
it will not be converted to a function key.
Popup window
Enter a range.  Ensure that the entries are relative to 
the line-numbering of the popup window—the frame of 
the popup window is line #1—and not to the line-
numbering of the original green screen.  If host text 
appears outside that range, it will not be converted to 
a function key.

Subfile Rule Base

Use the Subfile Rule base to define how MorphMaster 
identifies subfiles on host screens.  
Subfiles (tables) are indicated in the host screen by the 
presence of aligned, column-like text. MorphMaster identi-
fies columns by aligned display attributes, or by aligned 
spaces, based on definitions set in the Subfile Rule base 
files.
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To define how MorphMaster identifies subfiles on host 
screens:
1. Expand Subfiles > Rule base.
2. Select a parameter and enter the changes:

Header’s vertical separators
Click Add and enter the character that, when occurring 
in a header line, serves as a separator between 
columns.
Header’s horizontal separators
Click Add and enter the character that, when occurring 
in a header line, serves as a separator between the 
subfile header and the first row of data.
Data’s vertical separators
Click Add and enter the character that serves as a 
separator between columns of data.
Column number disqualifier
Change this parameter to reflect the common usage in 
your environment.  In many applications, fields and 
their captions look like two-column subfiles.  To 
prevent MorphMaster from misinterpreting these two-
column items as subfiles, the Minimum columns 
default setting is set at 3. This means that at least 
three columns must appear in the host screen for 
MorphMaster to convert them to a subfile.

3. Sometimes, host screen text that is not a subfile con-
tains subfile characteristics that cause MorphMaster 
to transform the text to a subfile.  To prevent Mor-

phMaster from making this mistake, in the three dis-
qualifiers, specify strings that, when present in the 
specified range, tell MorphMaster not to create a sub-
file.
Screen level disqualifier
Procedure:  Select Screen level disqualifier, click Add, 
and enter the string and the From line / To line range.
Explanation:  When the string is found within the 
specified range, MorphMaster will not create any 
subfiles in the screen.
Subfile level disqualifier
Procedure:  Select Subfile level disqualifier, click Add, 
and enter the string.
Explanation:  When the string is found inside text that 
is similar to a subfile, MorphMaster will not convert 
that part of the screen into a subfile.
Header’s top line trimmer
Procedure:  Select Header’s top line trimmer, click 
Add, and enter the string.
Explanation:  MorphMaster identifies the subfile's 
header by looking at the lines immediately above the 
subfile itself.  When lines above the header are 
formatted in a similar manner, MorphMaster may 
mistake them for part of the header.  To prevent this, 
define strings that identify lines outside the subfile 
header.  When MorphMaster encounters any of these 
strings, it assumes that this line and all lines above it 
are not part of the subfile header.
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4. Procedure:  Select Folded subfiles and, from the 
lower panel, select or clear Analyze folded subfile.
Explanation:  A host screen subfile that contains too 
many columns to fit on one line is folded over to the 
next line, so that one row of subfile text is displayed on 
two or more lines.  If the host application does not 
contain folded subfiles, deselect the check box to opti-
mize MorphMaster performance.

5. Procedure:  Select By header, click Add, and, in the 
lower panel, enter the string and the From line / To 
line range.
Explanation:  MorphMaster will identify subfiles based 
on the exact string which makes up the header.  
Columns: Click Columns to define data column-
dividers.   Dividers are vertical lines that separate 
between columns.  User definitions override the auto-
matic subfile columns analysis.
To configure:
a. Select Subfile > Rule Base > Subfile by Header.  
b. Click Columns.  A dialog box opens within which 

is defined the columns which will serve as column 
dividers.  

c. Enter the column numbers where dividers will 
appear. 

To disclose which numbers to enter, in the display ses-
sion legacy screen, place the cursor at the divider 

position. The column number is shown at the bottom 
right corner of the display session window. 
A list of column numbers can be defined.  The delim-
iter “;” (semi-colon) must be set between the numbers.  
Select the checkbox if the dividers will also be applied 
to folded subfiles.

Subfile Options Rule Base

If the screen contains a subfile, MorphMaster looks for 
subfile options.  Use this Rule base to define the charac-
teristics that enable MorphMaster to identify subfile 
options.
To define a new subfile option identifier:
1. Expand Subfile options > Rule base.
2. Select Suffixes and separators and click Add.
3. Enter the new suffix and separator in the field in the 

lower panel.
Suffix
Add additional strings that reflect the common usage 
in your environment.  A suffix is the character that 
links the code with its text.  For example, in the subfile 
option <F1=Create> the suffix is <=>.
Separator
Add additional strings that reflect the common usage 
in your environment.  A separator is the character that 
creates a visual break between one subfile option and 
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the next.  For example, in the subfile option pair 
<F1=Create F2=Next level> a space is the 
separator.

4. If you want to send ‘Enter’ after the subfile option 
number, select Action and select the checkbox in the 
lower panel.

Titles Rule Base

By default, MorphMaster looks for titles in the titles search 
area defined by the user and identifies them by a built-in 
algorithm.
If the titles in the host application appear in a different part 
of the screen, use the Titles Rules base to modify the 
search area accordingly.  You can modify both primary 
and secondary titles for regular windows and for popup 
windows.
To modify the search area:
1. Expand Titles > Rule base.
2. Expand either Primary title or Secondary title.
3. Expand either Full window or Popup window.
4. Enter the new search area in the corresponding file:

Lines range
Enter line numbers in the two fields.  MorphMaster will 
search for a title in the specified From / To range.

NOTE:  In the case of a From/To range for a popup window, 
ensure that the entries are relative to the line-numbering of the 
popup window—the frame of the popup window is line or column 
#1—and not to the line numbering of the original green screen..

Columns range
Expand either 80 Columns screen or 132 Columns 
screen  and enter line numbers in the two fields.    
MorphMaster will search for a title in the specified 
From / To range.

If the host application uses colored titles, you can override 
the title identification algorithm and identify titles by their 
display attributes.  If MorphMaster cannot identify screen 
titles by their display attributes, and if selected, Mor-
phMaster uses its Automatic search feature.
5. Select Attributes and click Add.
6. From the Attributes table, select the title’s original 

color.  (The Attributes table shows the Hex display 
attribute character with a description.  Any output with 
this attribute inside the search area will be identified 
by MorphMaster as a title.)

7. Select Automatic search if you want MorphMaster to 
use its built-in algorithm when no title is found by 
attributes.
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Panels Rule Base

Sometimes, MorphMaster creates panels where they are 
not suitable.  To prevent MorphMaster from making this 
mistake, define panel screen inhibitors.
1. Expand Panels > Rule base.
2. Select Screen inhibitors.

Procedure:  From the bottom panel, click Add, enter a 
string and a From line / To line range. 
Explanation:  When the string is present in the speci-
fied location, MorphMaster does not create any panels 
on the specific screen.  Other screens will have 
panels.

Popup Windows Rule Base

A popup window is a smaller window that opens on top of 
another screen called the “parent screen.”  MorphMaster 
recognizes a popup window by its frame, which can be a 
special color or repeated characters.
Use the Popup Windows Rule base to define how Mor-
phMaster will recognize host popups.
To define how MorphMaster will recognize host popups:
1. Expand Popup windows > Rule base.
2. Select an option.

Bordered by attributes
Procedure:  Click Add and select the corresponding 
attribute from the dropdown list.  

Explanation:  Some host applications use color 
borders to define popup windows.  This table shows 
the host color attribute that MorphMaster will use to 
identify the border of a popup window.
Bordered by characters
Click Add and enter the characters that form the 
popup window’s border.

3. Select Screen level disqualifier and click Add.
Procedure:  Enter the string and the From line / To 
line range.
Explanation:  Screen level disqualification is a defini-
tion that tells MorphMaster not to translate a host 
screen item into a popup window, even though the 
host item contains a popup window identifier.  Use 
screen level disqualification when a host screen item 
that is not a true popup window contains an identifier 
that would cause MorphMaster to mistakenly translate 
it. Make the string unique for these specific cases; oth-
erwise, MorphMaster might not translate host screen 
items that are, in fact, true popup windows.
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BOSâNOVA Web 
Data Transfer 

Functions (JDTF)

This section includes:
• Introducing JDTF, p. 66
• “Opening JDTF” on page 66
• Updating the List of Assigned JDTF Profiles, p. 67
• Working Offline, p. 67
• Running Data Transfer, p. 68
• Managing JDTF Profiles, p. 69
• Assigning JDTF Profiles, p. 78
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Introducing JDTF

JDTF (BOSâNOVA Web Data Transfer Functions) is 
included as part of the BOSâNOVA Web system. It is 
used for transferring data in either direction between your 
PC and the iSeries host.
JDTF is an SQL-based data transfer process in which 
JDTF acts as a client of the iSeries database server.
Data transfers are managed by file transfer profiles. 
These are files with an .h2p (host-to-PC) or .p2h (PC-to-
host) extension that contain information about the data 
and how it is to be transferred, for example, the source 
and destination paths, the transfer type, and conversion 
information. JDTF profiles contain this information com-
bined with an SQL query to the iSeries to perform the 
transfer.
The JDTF interface acts and functions according to the 
permissions set for you by your BOSâNOVA Web admin-
istrator.  Via the JDTF interface, you can (depending on 
your permissions):
• View profiles and profile lists
• Create profiles
• Change profile parameters
• Run data transfers

When a profile is launched (“Run”), the PC sends an SQL 
query to the database server of the host computer. The 
database server responds by sending either corre-
sponding data or an error.

Opening JDTF 

To open JDTF:
1. Log-in to BOSâNOVA Web.  (See “Logging In” on 

page 10.)
2. Click Options.  The Options menu is displayed.

              

3. Click JDTF.  The JDTF main window, shown on the 
following page, opens.
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NOTE:  If your JDTF permissions include some restrictions, you 
will receive a message to that effect.

Updating the List of Assigned JDTF Profiles 

Due to changes that the BOSâNOVA Web administrator 
may make in the list of profiles available to you, the list 
might not be updated automatically. With the Refresh 
option, you can update or refresh the list of profiles dis-
played in the JDTF main window.
To update the list of profiles, click Refresh in the JDTF 
main window.

Working Offline

Generally, JDTF is set to work online, that is, connected to 
the host. To save host resources while creating or 
changing profiles, clear Work online.
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Running Data Transfers

This section explains how to run data transfers.

Previewing JDTF Data Before Transfer

Use this option to view the data that is about to be down-
loaded to your PC from the iSeries host computer.
Note that this option is applicable only while using one of 
the Host-to-PC (*.h2p) JDTF profiles.
To view data to be downloaded to your PC:
1. From the JDTF main window, select the *.h2p profile 

that you are about to use for receiving data from the 
host.

2. Click Preview.
3. View the data to be downloaded to your PC: you may 

decide that this is not the data you need. In this case, 
you may need to use another *.h2p profile or create a 
new profile that fits your needs.

4. Click Close to return to the JDTF main window.

Transferring Data (Running a JDTF Profile) 

Use this option to activate an *.h2p or *.p2h profile to 
transfer data between your PC and the iSeries host com-
puter.
To start transferring data to/from your PC:
1. From the JDTF main window, select the profile that 

you are about to use for receiving or sending data to/
from your PC.

2. Click Run. The JDTF profile starts the data transfer 
session.

3. Follow the prompts.  When the transfer is completed, 
the number of transferred records is displayed.

4. Close this dialog box to return to the JDTF main 
window.
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Managing JDTF Profiles

This section explains how to manage your JDTF profiles.

Creating New JDTF Profiles

To create a new JDTF profile:
1. From the JDTF main window, click Add.  A popup 

menu is displayed.
2. From the popup menu, click Profile.  The New Profile 

dialog box opens.

              

3. Select the host name from the dropdown list.
4. Determine the direction of the data transfer:

Host-to-PC
Downloads data from the iSeries host computer to 
your PC (this creates an *.h2p file).
PC-to-Host
Uploads data from your PC to the iSeries host 
computer (this creates a *.p2h file).

5. From the Transfer Type box, select the type of data 
that will be transferred:
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Database
Select this option if your host file consists of more than 
one field.
Plain (no conversion)
Select this option to set a specific structure of data 
query. This structure is comprised of only one field; 
typically you select this type when using files imported 
from S/36 computers.
Source
Select this option to use a pre-defined field structure. 
This is a common and well-known structure among 
iSeries programmers. This structure is comprised of 
three fields: record number, last modification date, and 
alphanumeric field.

6. Click OK.  If the Sign-on Bypass option was not 
assigned to you (by your BOSâNOVA Web adminis-
trator), the Sign-on dialog box opens.  Enter your User 
ID and Password. Click Sign-on to connect. 

7. If you selected the Host-to-PC type of profile, the fol-
lowing dialog box opens.

              

If you selected the PC-to-Host type of profile, a similar 
dialog box opens but with no Edit SQL and View SQL 
buttons:
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8. Enter the name for the new profile in the Profile name 
field.

9. Enter the host file location path, or click  to browse 
to the location of the file from where the data will be 
downloaded, or to where the data will be uploaded. 
Specify host location by using the syntax: “Library 
name/Filename (member name).”

10. For Host to PC profiles only:  In the host file location 
field, specify all the physical files from where the data 
will be transferred. If more than one file is specified, 
edit the SQL query (click Edit SQL) to define at least 
the JOIN conditions.

11. For Host-to-PC profiles only: Click View SQL to 
view the current SQL structure. The SQL Viewer 
screen opens.  Click Close to return to the previous 
screen.
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12. For Host-to-PC profiles only: Click Edit SQL to 
rebuild or modify the data sequence that will be sent 
from the data table. The SQL Editor screen opens.

NOTE:  For more and detailed information on the DB2 and SQL, 
see the Web site: http://www.as400bics.rochester.ibm.com/cgi-bin/
bookmgr/bookmgr.cmd/books/

13. To set the PC file location path, click  to browse to 
the location of the file from which the data will be 
downloaded or to which it will be uploaded.

14. For Host-to-PC Profiles Only:
a. Click Options. The Options dialog box opens with 

the Basic tab on top.
              

b. Select one of the following PC write mode options:
• Create/Replace file  

To replace an existing file or create a new file 
on your PC.

• Create/Append file  
To create a new file or add new data at the end 
of an existing file.

c. Select one of the following PC file types:
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• CSV (comma delimiter): To use commas to 
separate adjacent fields. Text fields are 
enclosed by double quotation marks (for 
example: “John”, “Smith”, 012345).

• PRN (space delimiter): To use a space to 
separate adjacent fields.

• TXT (tab delimiter): To use a tab to separate 
adjacent fields.

• TXT (without delimiter): To use no separation 
between adjacent fields.

d. Select one of the following definitions for the 
Decimal symbol:
• . (dot): To use a dot as the decimal point 

symbol.
• , (comma): To use a comma as the decimal 

point symbol.
e. Select one of the following definitions for the end 

of a line:
• Carriage return/line feed: To end a line by 

using either a carriage return or line feed 
keyboard key.

• Carriage return: To end a line by using the 
carriage return keyboard key.

• Line feed: To end a line by using the line feed 
keyboard key.

f. Select the Preserve field length option to 
preserve the field length as defined on the host 
file.

g. Select the Interpret Hex as Char fields option to 
translate this field’s contents to ASCII/ANSI.
If there is an alphanumeric field in your host file 
that has CCSID = 65536 (-1), such a field is 
considered to be HEX. If you don’t select the 
Interpret Hex as Char fields option, its contents will 
be transferred “as is.”

h. Select the Character Set tab.
              

i. In some cases, you have two ASCII tables for your 
EBCDIC code page. Choose the appropriate one 
from the dropdown list.

j. Select the way that the PC file data will be 
encoded during transfer: ASCII or ANSI.

15. Click OK to return to the JDTF main window.
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16. For PC to Host Profiles Only:
a. Click Options. The Options dialog box opens with 

the Basic tab on top.
              

b. Select one of the following host write mode 
options from the dropdown list:
• Create file: To create a new file on the host 

(this requires that you define the Reference 
Library and the Reference File in the host tab; 
see the next page).

• Create member: To create a new member in 
an existing file.

• Replace member: To replace the data of an 
existing member.

• Append member: To add data to the end of an 
existing member.

c. Select one of the following PC file type options 
from the dropdown list:
• CSV (comma delimiter): To use commas to 

separate adjacent fields. Text fields are 
enclosed by double quotation marks (for 
example: “John”, “Smith”, 012345).

• PRN (space delimiter): To use a space to 
separate adjacent fields.

• TXT (tab delimiter): To use a tab to separate 
adjacent fields.

• TXT (without delimiter): To use no separation 
between adjacent fields.

d. Select one of the following definitions for the 
Decimal symbol:
• . (dot): To use a dot as the decimal point 

symbol.
• , (comma): To use a comma as the decimal 

point symbol.
e. Select the Interpret Hex as Char fields option to 

translate this field’s contents to ASCII/ANSI.
If there is an alphanumeric field in your host file 
that has CCSID = 65536 (-1), such a field is 
considered to be HEX. If you don’t select the 
Interpret Hex as Char fields option, its contents will 
be transferred “as is.”

f. Select the Host tab.
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NOTE:  Some of the dialog boxes may not appear depending on 
the Host write mode selection you made previously in the Basic tab.

              

g. Browse to the Reference library where you want to 
create a file.

h. Browse to the Reference file where you want to 
add data or replace the file.

i. Enter the File text description (optional, text only).
j. Enter the Member text (optional, text only).
k. Select the definition for the Authority according to 

IBM standards.
l. Select the Character Set tab.

              

m. In some cases, you have two ASCII tables for your 
EBCDIC code page. Choose the appropriate one 
from the dropdown list.

n. Select the way that the PC file data will be 
encoded during transfer: ASCII or ANSI.

17. Click OK to return to the JDTF main window.
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Creating a New JDTF Profile List

To transfer more than one profile at a time, create a profile 
list.

NOTE:  Create a profile for each transfer before creating the profile 
list and add profiles to the list in the order you want to transfer them.

1. From the JDTF main window, click Add.  The popup 
menu opens.

2. From the popup menu, click Profiles list.  The Pro-
files List dialog box opens.

              

3. In the File name field, enter a name for the profile list.
4. From the Groups list, select a group with profiles you 

want to add to the profile list.

5. From the Profiles list, select a profile.  You can hold 
down Ctrl and multi-select profiles.

6. Click Add.  The selected profile is added to the new 
Profile list.

7. Continue adding profiles to the list in the order you 
want to transfer them.  To add profiles from a different 
group, repeat steps 4–6.

8. To remove a profile from the list, select the profile and 
click Remove.

9. To continue the transfer of listed profiles even after a 
failed transfer attempt, select Continue profile 
transfer after a failed or an interrupted attempt.

10. When the Profile list is finished, click OK.  The Profiles 
List dialog box closes and the new profile list, with a 
.prl extension, appears in the JDTF main window.

To change an existing profile list:
1. From the JDTF main window, select the profile list you 

want to modify.
2. Click Change.  The Profile List dialog box opens.
3. Complete the changes and click OK.
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Viewing JDTF Profile Properties

Use this option to view the properties and parameters of 
an existing JDTF profile.
1. From the JDTF main window, select a profile and click 

View. The View Profile window opens.
2. Click Close to return to the JDTF main screen.
To change any of the viewed parameters, return to the 
JDTF main window and click Change.  Follow the proce-
dure on p. 77.

NOTE:  It is recommended that you view JDTF properties before 
you change any parameters.  

Modifying a JDTF Profile

Use this option to change any parameter or property 
(excluding direction) of an existing JDTF profile.  All the 
dialog boxes are identical to those displayed while cre-
ating a new JDTF profile. 

NOTE:  It is recommended that you view JDTF properties before 
you change any parameters (see Viewing JDTF Profile Properties 
on page 77).

To modify parameters and properties of an existing JDTF 
profile:
1. From the JDTF main window, click Change. The 

Change Profile screen opens (same as the New Pro-
file screen).

2. Modify profile parameters or properties as required.
3. Click OK to save the changes and return to the JDTF 

main window.

Creating a New JDTF Profile Based on an 
Existing One

Use this option to create a new JDTF profile based on an 
existing one; for example, you may already have a profile 
that basically fits your needs, but needs a few modifica-
tions. All the dialog boxes are identical to those displayed 
while creating a new JDTF profile.
To modify parameters and properties of an existing JDTF 
profile:
1. From the JDTF main window, click Duplicate.
2. Select the profile to copy and assign a new name to 

the profile.
3. Follow the instructions in the “Creating New JDTF 

Profiles” on page 69, to set the parameters/properties 
of the new profile.
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4. When you have finished, click OK to save the new 
profile properties and return to the JDTF main window.

Removing a JDTF Profile

To completely remove a JDTF profile:
1. From the JDTF main screen, select the profile to 

delete.
2. Click Remove.  The Confirmation dialog box opens.  

Click Yes to confirm the profile deletion.
3. Click Yes. The profile is deleted and disappears from 

the JDTF main window’s tree structure.

NOTE:  If the profile you are deleting belongs to a profile list, a 
second dialog box—the Remove profile dialog box—opens.  This 
dialog box alerts you to the fact that the profile belongs to a profile 
list and displays the path of the profile list.  Click OK to delete the 
profile and, when necessary, make corrections to the profile list.

Assigning JDTF Profiles

Use this option to assign a personal JDTF profile to 
Groups, Users, or as Common (that is, permitted to all 
groups of users that were permitted to use JDTF).
To assign a JDTF profile:
1. From the JDTF main window, click Export.  The 

Export/Import dialog box opens.
              

2. From the Groups dropdown list, select a group.
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3. To add a profile to the selected group:
a. Select a profile from the Personal profiles list.
b. Click Export to assign the profile to the selected 

group. The profile now appears under Profiles on 
the right.

4. To copy a profile from the selected group to the per-
sonal profile list:
a. Select a profile from the Profiles list.
b. Click Import to copy the profile from the selected 

group and assign it to the Personal profiles list.
5. Click Close to return to the JDTF main window. Note 

the changes in the tree structure.
    
Previous Page Contents 79 Index Next Page



BOSâNOVA Web User Guide
The Printer 
Emulation

This section includes:
• “Overview of Printer Sessions” on page 81
• “Starting and Stopping a Printer Session” on page 82
• “Viewing Printer Session Properties” on page 82
• “Opening the Printer Session Properties” on page 83
• “Printer Session Properties” on page 83

NOTE:  The BOSâNOVA Web Printer Client (Jpc.exe) file can not 
be opened from Netscape’s Download dialog box.  Instead, record 
the location where the download will be saved.  When the download 
is completed, locate the file Jpc.exe and, from the right-click popup 
menu, select Open.  Follow the prompts of the installation 
procedure.
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Overview of Printer Sessions

Printer  emulation is the process of transforming iSeries 
data output into an ASCII data stream.  This allows you to 
use a PC printer as an iSeries system printer.  The fol-
lowing flowchart provides an overview of the printer emu-
lation process.

              

With BOSâNOVA Web printer emulation, you manage 
and configure the printing process using printer session 
profiles.  Printer session profiles are configured by your 
BOSâNOVA Web administrator. 
The printer session runs on your PC and acts as a printer 
running in the background waiting for print jobs. The 
printer session communicates with the iSeries host and 
with the printer.
With BOSâNOVA Web printer emulation, you can use 
print settings controlled by the host or settings controlled 
by the PC printer. When you print with Host Print Trans-
form  enabled, the printing process and printing configura-
tion is controlled by the host (see “Host Print Transform” 
on page 129).  That means that settings can’t be changed 
in the via the Printer Session Properties configurator (see 
“Printer Session Properties” on page 83).
If you disable Host Print Transform, you can control and 
configure the printing process via the Printer Session 
Properties configurator.

Host Application

Print Output Queue

PC

   Printer Session

BOS Emulation

Is 
HPT or ASCII 
transparent
enabled? 

EBCDIC-to-ASCII 
transform

Page Setup

Are you
using the

current Windows 
driver?

Windows GDI
(Graphic Device Interface)

Windows driverBOS Custom Driver

Printer Port

Printer

No Yes

Yes

No

IBM iSeries

Display Session
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Basics of a Printer Session

This section describes opening and closing printer ses-
sions, and viewing the current properties.

Starting and Stopping a Printer Session

To start a printer session:
1. Log in to BOSâNOVA Web (see “Logging In” on 

page 10).
2. Select a printer session.
3. Right-click the session.  A popup menu is displayed.

              

4. Click Start. The Printer Session Status changes to 
Active.  If this is the first session running on the PC, 

the  icon appears in the task bar.
5. To close a Printer Session, right-click the session and 

click Stop.

Viewing Printer Session Properties

To view a printer session’s properties:
1. Log-in to BOSâNOVA Web.
2. Select a printer session.
3. Right-click the session.  A popup menu is displayed.
4. Click Properties.  The Properties window is dis-

played.
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Previewing a Print Job

To preview a print-job:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the Printer Session Properties configurator (see 

“Printer Session Properties” on page 83).
3. Select the Diagnostic tab.
4. Select Activate Diagnostic Mode.  
5. Select Print Preview.
6. Click OK to close the dialog box.
7. Send the print job. It prints to the screen in a standard 

Windows print preview format (that is, no output is 
sent to the printer). You can scroll through the pages 
and spot potential problems before sending the print 
job to the physical printer.

Printer Session Properties 

Use the Printer Session Properties configurator to define 
all parameters relevant to printer sessions.  
Printer Session Property parameters are divided into the 
following tabs: General, Previous Job Attributes, Page 
Setup, Diagnostic, and Advanced.

Opening the Printer Session Properties

To open Printer Session Properties:
1. Open a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).

2. Right-click the  icon in the task bar.  A popup menu 
is displayed which lists the names of the companies, 
that is, the active BOSâNOVA Web servers.

              

In this picture, the local station has activated three 
printer sessions from the server named My Company 
and printers from the server named Shomera.
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3. Point at a server name.  A sub-popup menu is dis-
played which lists the names of the active printer ses-
sions.

4. Click the name of a printer session.  Printer Session 
Properties opens.  The General tab is displayed.

The General Tab 

This tab contains parameters for defining the printer driver 
and job timeout settings.

              

Changing the Printer Driver

With BOSâNOVA Web, you can print using your default 
Windows printer driver or you can bypass Windows 
printing by defining your own custom printer driver.
To change the printer driver:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
3. Select the General tab.
4. There are two possibilities: 

• If Current Windows driver is selected, select 
Custom driver instead. 

• If Custom driver is already selected, continue with 
step 5.

5. From the dropdown list, select a printer.
6. Click OK to close the dialog box.

Selecting a Printer

To select the printer that print-jobs will be sent to:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
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3. Select the General tab.
4. Click Select Printer.  The standard Windows Print 

Setup dialog box is displayed.
5. Select a printer.
6. Click OK to close the Windows Print Setup dialog box.
7. Click OK to close the BOSâNOVA Web Printer Ses-

sions Properties dialog box.

Printing a Test Page

To send a test page to a local printer:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
3. Select the General tab.
4. Click Print Test Page.
5. Click OK to close the dialog box.

Changing the Timeout Setting

The Timeout Setting is the maximum amount of time that 
can elapse between buffers received from the host before 
BOSâNOVA Web assumes that the end of the print job 
has occurred.  During troubleshooting, you may need to 
increase this number.  (The default job timeout is 10 sec-
onds.) 
To change the Timeout Setting:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
3. Select the General tab.
4. Enter a number in the Job timeout field.
5. Click OK to close the dialog box.

NOTE:  For more information, see “Changing the Printer Driver” on 
page 84.  For assistance in choosing whether to work with the 
windows printer driver or a custom driver, see Windows vs. Custom 
Driver on page 131.
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Previous Job Attributes Tab

The left pane displays the attribute values of the most 
recent host print job. The right pane displays the corre-
sponding local printer settings (converted from the host 
attributes by the BOSâNOVA Web printer session).

              

The * (asterisk) character means the default value is dis-
played.  
If a Host Print Transform job is received, these values are 
not displayed.  Rather, a short message indicates that this 
is an HPT job.

The Page Setup Tab

This tab contains parameters for defining how to fit the 
print data to the output page, which paper source and 
page size and margins to use, and whether the host or the 
PC printer controls these settings.
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Changing Printer Drawer and Page Settings 

To change these parameters:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
3. Select the Page Setup tab.
4. Expand the Paper Source and Size branch.
5. Select Drawer Translation.
6. In the bottom pane, select the desired drawer setting/

page name and click the Change button.
7. Change the settings as needed.
8. Click OK in each dialog box to save the changes and 

close the dialog box. The changes take effect when 
you return to the emulation.

Changing Parameter Control Settings

To change these parameters:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
3. Select the Page Setup tab.
4. Select the Parameter Control branch in the top pane.

5. In the bottom pane, under Control settings, select 
either Automatic Control or Manual Control.
Automatic Control
The PC printer automatically adjusts the CPI, LPI and 
orientation to fit the print data of each print job to the 
output page according to the priority guideline you set.
Manual Control (default)
You set the CPI, LPI, and orientation parameters and 
you determine whether and how the host or the printer 
emulation will control these parameters.

NOTE:  Use Manual control only if Automatic control does not 
produce the desired results.

6. In the top pane, expand the Parameter Control 
branch.

7. Select the control setting that appears under Param-
eter Control.  There are two possibilities:
• If you selected Automatic Control, select one of 

the three priority options displayed in the bottom 
pane.  The other parameters are adjusted to 
match the prioritized parameter.
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• If you selected Manual Control:
i. Expand the Manual branch.  The sub-

branches CPI, LPI, and Orientation are 
displayed.

              

ii. Select one of the sub-branches.  As illustrated 
in the following three pictures, the 
corresponding dialog box is displayed in the 
bottom pane.

                    

iii. Select either Host, Set at, or Best fit.  These 
parameters are explained in Table 5, “Page 
Setup Options per Parameter,” on page 89.

iv. Repeat step iii for each parameter.
v. Click OK to close the dialog box.  The changes 

take effect when you return to the emulation.
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Table 5: Page Setup Options per Parameter

CPI Settings LPI Settings Orientation Settings

Host

The host retains control 
over CPI settings; that is, 
the printer emulation 
applies the CPI value it 
receives from the host.

The host retains control 
over LPI settings; that is, 
the printer emulation 
applies the LPI value it 
receives from the host.

The host retains control 
over orientation settings; 
that is, the printer emula-
tion applies the orienta-
tion setting it receives 
from the host.

Set at

The PC printer controls 
the CPI, which is set to a 
particular value for all 
print jobs (select from the 
dropdown list). The 
options that appear in the 
list are set in Advanced 
Settings > CPI Transla-
tion.

The PC printer controls 
the LPI, which is set to a 
particular value for all 
print jobs (select from the 
dropdown list).

The PC printer controls 
the orientation, which is 
set to portrait, landscape, 
or COR (Computer Out-
put Reduction) for all 
print jobs (select from the 
dropdown list).

Best fit

The PC printer retains 
control, but sets the CPI 
dynamically, based on 
the “best fit.”

The PC printer retains 
control, but sets the LPI 
dynamically, based on 
the “best fit.”

The PC printer retains 
control, but sets the ori-
entation dynamically, 
based on the “best fit.”
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Overview of CPI, LPI, and Orientation

This section provides an overview of:
• CPI, see p. 90
• LPI, see p. 91
• Orientation, see p. 91

Understanding CPI

CPI is characters per inch, that is, the number of charac-
ters in a horizontal inch. When the printer emulation 
receives a print job, it adjusts the CPI of the host print 
data to fit the printer output page according to the CPI set-
tings. That is, it either uses the CPI value sent from the 
host, uses a value set in the printer emulation, or adjusts 
the CPI or other parameters (for example, LPI or orienta-
tion) to create the best fit.  

NOTE:  The host may send information based on the font identifier 
instead. In this case, the printer emulation uses a different value to 
adjust the print data to the output page. See Understanding Font 
Identifiers and Determining CPI vs. Font ID Control, p. 93.

If you defined the host printer device to use Host Print 
Transform or ASCII Transparent, BOSâNOVA Web 
passes the buffers directly to the printer. In this case, 
BOSâNOVA Web has no control over the CPI, LPI, or any 
other print parameters.

If Host Print Transform is disabled, BOSâNOVA Web con-
trols the print parameters according to what you set in 
Printer Session Properties > Page Setup tab > Parameter 
Control.
If you are using Automatic control (default), the PC printer 
automatically adjusts the CPI, LPI, and orientation to fit 
the print data of each print job to the output page 
according to the priority guideline you set.
If Automatic control does not produce satisfactory print 
output, use Manual control with which you set the CPI, 
LPI, and orientation parameters and you determine 
whether and how the host or the printer emulation will 
control these parameters.
Adjusting the CPI
In some cases, you need to know whether a print job is 
controlled by host CPI values or by host font identifiers 
(Font ID) in order to modify a setting or correct a problem.

NOTE:  It is recommended that before you change a CPI setting, 
you first measure (or calculate) the CPI of the print output page. 
This value may be needed at a different point in the troubleshooting 
or problem-solving process (see Calculating the CPI on page 91).

You can change the CPI setting by defining a fixed CPI 
value (Set At), a dynamic setting (Best Fit), or the value 
received from the host (Host).
When you work with Automatic control or with the Host 
setting under Manual control or with a custom printer, 
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BOSâNOVA Web maps the CPI values received from the 
host to supported PC printer values. You may need to 
adjust this mapping, called CPI translation, or to add new 
mapping pairs.
Calculating the CPI
There are two methods for calculating the CPI:
• Using a ruler (in inches), measure one (1) inch on the 

print output page and count the number of characters 
(including spaces, numbers, punctuation, and other 
special characters).

• Count the number of characters in a line (including 
spaces, numbers, punctuation, and other special char-
acters). Take the page width (in inches) and divide it 
by the number of characters per line. That is:
CPI = Page width (inches)/Characters per line.

NOTE:  You can use the same methods for calculating (or 
counting) the printed CPI on an output page or for calculating a 
desired CPI value.

Understanding LPI

LPI is Lines Per Inch, that is, the number of lines in a ver-
tical inch.
If you defined the host printer device to use Host Print 
Transform, BOSâNOVA Web passes the buffers directly 
to the printer. In this case, BOSâNOVA Web has no con-
trol over the CPI, LPI, or any other print parameters.

If Host Print Transform is disabled, BOSâNOVA Web con-
trols the print parameters according to what you set in 
Printer Session Properties > Page Setup tab > Parameter 
Control.
If you are using Automatic control (default), the PC printer 
automatically adjusts the CPI, LPI, and orientation to fit 
the print data of each print job to the output page 
according to the priority guideline you set.
If Automatic control does not produce satisfactory print 
output, use Manual control with which you set the CPI, 
LPI, and orientation parameters and you determine 
whether and how the host or the printer emulation will 
control these parameters.

Understanding Orientation

Orientation refers to paper rotation (portrait or landscape).
When the printer emulation receives a print job, it adjusts 
the orientation of the host print data to fit the printer output 
page according to the orientation and/or other print 
parameter settings. That is, it either uses the orientation 
value sent from the host, uses a value set in the printer 
emulation, or adjusts the orientation or other parameters 
(for example, CPI or LPI) to create the best fit. 

NOTE:  The host may send information based on the CPI or the 
font identifier instead. In this case, the printer emulation uses a 
different value to adjust the print data to the output page.
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If you defined the host printer device to use Host Print 
Transform, BOSâNOVA Web passes the buffers directly 
to the printer. In this case, BOSâNOVA Web has no con-
trol over the orientation or any other print parameters.
If Host Print Transform is disabled, BOSâNOVA Web con-
trols the print parameters according to what you set in 
Printer Session Properties > Page Setup tab > Parameter 
Control.
If you are using Automatic control (default), the PC printer 
automatically adjusts the CPI, LPI, and orientation to fit 
the print data of each print job to the output page 
according to the priority guideline you set.
If Automatic control does not produce satisfactory print 
output, use Manual control with which you set the CPI, 
LPI, and orientation parameters and you determine 
whether and how the host or the printer emulation will 
control these parameters.
Changing the Orientation
You can change the orientation setting by defining a fixed 
orientation value (Set At), a dynamic setting (Best Fit), or 
the value received from the host (Host).
If you are having a problem with the orientation of your 
print output, see the Flowcharts in Printer Trouble-
shooting, p. 103.

Font Identifiers

A font identifier is a number that represents a particular 
host font. Hosts may send a print job with a host font iden-
tifier or with a CPI (characters per inch. that is, the 
number of characters in a horizontal inch) value.
When the printer emulation receives a print job that is 
controlled by font identifiers (see Determining CPI vs. 
Font ID Control on page 93), it uses the font translation 
values to adjust the host print data to fit the printer output 
page.
When you work with Automatic control or with the host 
setting under Manual control or with a custom printer, 
BOSâNOVA Web maps the Font ID values received from 
the host to supported PC printer values. You may need to 
adjust this mapping, called font translation, or to add new 
mapping pairs.
These settings should be changed only if your print output 
is unsatisfactory and you have determined that the 
problem is in the font ID translation (see Printing Emula-
tion Troubleshooting – Main Flowchart on page 103).
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Determining CPI vs. Font ID Control 

In some cases, you need to know whether a print job is 
controlled by host CPI values or by host font identifiers 
(Font ID) in order to modify a setting or correct a problem.
To determine the control type:
1. Send a print job.
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
3. Select the Previous Job Attributes tab. The Pre-

vious Job Attributes tab opens.
              

4. In the left pane, under Previous host job attributes, 
check the Font Identifier parameter:
• If the value is *CPI, either this print job is 

controlled by host CPI values or the host did not 
send a font ID.  In that case, the printer emulation 
uses the CPI that was sent.

• If the value is not *CPI, this print job is controlled 
by font identifiers.  Write down the Font ID number.

5. Close this dialog box.  If the print job is controlled by 
CPI values, see Changing CPI Translation on 
page 93.  If the print job is controlled by font identi-
fiers, see Changing Font Translation on page 95.

Changing CPI Translation

When you work with Automatic control or with the host 
setting under Manual control or with a custom printer, 
BOSâNOVA Web maps the CPI values received from the 
host to supported PC printer CPI settings.  You may need 
to adjust this mapping, called CPI translation, or to add 
new mapping pairs.  

NOTE:  These settings should be changed only if your print output 
is unsatisfactory and you have determined that the problem is in the 
CPI translation (see Printer Troubleshooting Flowcharts, p. 103).
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To change the CPI translation:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
3. Select the Page Setup tab.
4. Expand the Advanced Settings branch.
5. Select the CPI Translation sub-branch.

              

6. In the bottom pane, select a host CPI (Characters Per 
Inch) value from the dropdown list.

7. Complete one of the following:
• To add a new CPI value to the list, click the Add 

button.  The Add New CPI dialog box opens.
              

• To change a translation (or mapping), select it and 
click the Change button.  The Change CPI 
Settings dialog box opens.

CAUTION!
If you delete a value from the list, you will not be able to print it.  If 
you accidentally delete a CPI value, select Advanced Settings in 
the top pane and click Restore Defaults in the bottom pane.  This 
will restore the deleted CPI and all other default settings.

8. In the Add/Change CPI Settings dialog box, select a 
Host CPI, Printer CPI, and Style from the dropdown 
menus.

9. Click OK to close the dialog box. The changes take 
affect when you return to the emulation.
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Changing Font Translation

When you work with Automatic control or with the host 
setting under Manual control or with a custom printer, 
BOSâNOVA Web maps the font ID numbers received 
from the host to supported PC printer font settings. You 
may need to adjust this mapping, called font translation, 
or to add new mapping pairs. 

NOTE:  These settings should be changed only if your print output 
is unsatisfactory and you have determined that the problem is in the 
font ID translation (see Troubleshooting Flowcharts, p. 103).

To change the font translation:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
3. Select the Page Setup tab.
4. Expand the Advanced Settings branch.
5. Select the Font Translation sub-branch.
6. In the bottom pane, select a font setting.
7. Complete one of the following:

• To add a new font ID to the list, click the Add 
button.  The Add New Font dialog box opens.

              

• To change a setting, click the Change button.

CAUTION!
If you delete a font ID from the list, you will not be able to print it.  If 
you accidentally delete a font ID, select Advanced Settings in the 
top pane and click Restore Defaults in the bottom pane.  This will  
restore the deleted font and all other defaults.

8. In the Add/Change New Font dialog box, select a 
Host font ID, Printer CPI, and style from the drop-
down menus.

9. Click OK to close the dialog box.  The changes take 
affect when you return to the emulation.
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Testing a Printing Configuration

After you change a printer session setting, send the same 
print job to the printer to see if it now prints correctly.

Diagnostic Tab

The Diagnostic tab contains parameters for collecting 
printer troubleshooting information.  If you contact BOS 
Technical Support, they may instruct you to set a partic-
ular diagnostic mode configuration.

              

NOTE:  For more and detailed information on how to troubleshoot 
printing problems, see Diagnosing Printing Problems on page 102.

Activating or Changing the Diagnostic Mode

To activate the diagnostic mode:
1. Start a Printer Session (see “Starting and Stopping a 

Printer Session” on page 82).  
2. Open the session’s Printer Session Properties config-

urator (see “Printer Session Properties” on page 83).
3. Select the Diagnostic tab.
4. Select Activate diagnostic mode.
5. Select one of the following output options:

None
Collects troubleshooting information without actually 
printing (that is, no output is sent to the printer). You 
use this setting to determine if the printing problem 
originates in the printer emulation or elsewhere in the 
system.
Normal Print
Prints normally using the default Printer Control Panel 
settings (that is, the same output as when Activate 
diagnostic mode is not selected). If you select this 
option and select Save to EBCDIC file, you will 
generate both a host output file and a printer output 
hardcopy for BOS Technical Support.
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Print Preview
Prints to the screen in a standard Windows print 
preview format (no output is sent to the printer). You 
can scroll through the pages and spot potential 
problems before sending the print job to the physical 
printer.
Save to ASCII File
Writes the print job output to an ASCII file (no output is 
sent to the printer). This preserves the exact 
information that the print device received. Enter the 
path and filename (extension .asc) or click Browse to 
locate a file. The file can later be sent to the printer. 
This file is overwritten each time you send a new print 
job.
Save to EBCDIC File
Writes the print job output to a binary file (containing 
EBCDIC characters). This preserves the exact host 
output with no translation or conversion. Enter the 
path and filename (extension .ebc) or click Browse to 
locate a file. The saved file can be printed later by 
clicking Print EBCDIC File. This file is added to each 
time you send a new print job.
Create Data Stream Commands File
Select this option to create a file containing only the 
print commands received from the AS/400, for 
example, margins, orientation, CPI, LPI, host drawer, 
etc.  (It does not contain the actual text of the print 
job.)  Enter the path and filename (extension .dsc) or 

click Browse to locate a file.  The saved file can be 
opened in any text-editor and printed.  Additional 
records are appended to the existing log each time 
you receive a new print job.
Print EBCDIC File
Opens a standard file browsing dialog box for 
selecting the file to be printed.
Collect Technical Support Information
Creates a file containing system information 
(computer, CPU, memory consumption, disk 
consumption),  print information (where print sessions 
are connected, translation tables), any diagnostic files 
you generated, the user information file (if you 
completed it), etc. The file (default filename is 
Bsinfo.bts) is located in the BOSâNOVA Web folder. 
You can specify another filename or folder in which to 
save this file. This file should then be sent to BOS 
Technical Support.

Collecting Technical Support Information 

Use the User Information dialog box to collect printer trou-
bleshooting information in Printer Session Properties > 
Diagnostic tab.
The information you enter in these fields will be written to 
a text file when you click OK. The default file is Bsinfo.bts 
in the BOSâNOVA Web installation folder. Include this file 
along with any trace (dump) files or recorded windows for 
BOS Technical Support.
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NOTE:  The file also automatically includes other information 
including system information plus the specific printer session.

To collect and send Technical Support Information:
1. Click the Collect Technical Support Information 

button in the Diagnostic tab. The User Information dia-
log box opens.

              

2. Fill in the following data:
a. Your Name: By default, the name you used when 

installing BOSâNOVA Web will be used. You can 
change this.

b. Company: By default, the company name you 
used when installing BOSâNOVA Web will be 
used. You can change this.

c. Address: Enter your full mailing address, 
including the postal code and country.

d. Phone Number: Enter a daytime phone number 
where we can reach you. Users outside the US 
are requested to include the country code.

e. E-mail Address (If available).
f. Tech Support Call #: This number will be 

provided by BOS Technical Support. Make sure to 
include it so that your diagnostic files can be 
properly tracked.

g. Host Type: Enter your host type (iSeries, System/
36, AS/36, etc.).

h. Host OS Version: Enter the complete version 
number of your host operating system.

i. Description: Describe the problem carefully. 
Under what circumstances does the problem 
occur? Are you able to duplicate it? Have you 
made any changes to your connectivity hardware 
or software that could contribute to this?

j. Click OK. The default file Bsinfo.bts is created in 
the BOSâNOVA Web installation folder.
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Advanced Tab

This tab contains parameters for page orientation and 
margin settings.

              

Old Fashioned Orientation
Select this checkbox if portrait orientation is required but 
Automatic Rotation is selected.
Top Margin Settings
This parameter determines the margin at the top of the 
page.  Select an option:

• When AVPP Value Only is selected, the margin is 
determined by the Absolute Vertical Presentation 
Position (AVPP) line specified by the host.  The 
Set Vertical Margin (SVM) is ignored.

• When AVPP + SVM is selected, both parameters 
are used to determine the top and bottom margins 
on the page.

Left Margin Settings
This parameter determines the margin at the top of the 
page.  Absolute Horizontal Presentation Position (AHPP) 
moves the print position to the horizontal position speci-
fied by the host.  Set Horizontal Margin (SHM) specifies 
the left and right margins in 1/1440ths of an inch.  Margins 
settings are always relative to the physical left margin.

• When AHPP Value Only is selected, the margin is 
determined by the Absolute Horizontal 
Presentation Position (AHPP) line specified by the 
host.  The Set Horizontal Margin (SHM) parameter 
is ignored.

• When AHPP + SHM is selected, both parameters 
are used to determine the left and right margins on 
the page.

End of Job Settings
These parameters create additional flexibility vis-a-vis  
layout and routing.

• When Activate End of Job Sequence after Each 
Page is selected, BOSâNOVA Web responds to a 
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FORMFEED command as if it were an End of Job 
sequence.  This enables you to break up a job into 
multiple, smaller jobs.  For example, if page 1 of a 
job is to be printed with a Portrait orientation, 
whereas page 2 is to be printed with a Landscape 
orientation, this parameter could send page 1 to 
Tray 1 and page 2 to Tray 2.

• When Ignore End of Job Sequence is selected,  
the parameters defined at the  beginning of the job 
are saved throughout the entire job and for every 
page of the job.
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Troubleshooting This section includes:
• Printer Emulation Troubleshooting, p. 102
• Error Messages, p. 114
• “Uninstalling” on page 126
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Printer Emulation 
Troubleshooting

Diagnosing Printing Problems

When a print job doesn’t print satisfactorily, you must 
determine where in the process the problem occurred in 
order to fix it.
The flowcharts in this section help you determine what 
went wrong, where it occurred in the process, and how to 
reconfigure to solve the problem.

Collecting Troubleshooting Information

If you have tried to solve your printing problem using the 
flowcharts and other troubleshooting information and the 
problem persists, collect the following troubleshooting 
information and send it to BOS Technical Support.
1. In Printer Session Properties > Diagnostic tab, select 

Activate diagnostic mode, select Save to ASCII file, 
and select Save to EBCDIC file.

2. Click OK.

3. Send a print job.
4. Collect the troubleshooting information:

a. Right-click the  icon in the task bar.
b. Select Properties to open Printer Session 

Properties.
c. Select the Diagnostic tab.
d. Click Collect Technical Support Information.

5. Fill out the User Information form.
6. Fax or email the information to BOS Technical Sup-

port. Include a fax of a good and a bad printout, that is, 
an example of how the printout should appear and a 
copy of the unsatisfactory printout you are getting.
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Printing Emulation Troubleshooting – Main 
Flowchart  

Start troubleshooting from this flowchart.

              

With HPT, printing is
controlled by the host
and can't be modified
by the printer
session.

If you want to
transfer control to the
printer emulation,
disable HPT. If not,
see your iSeries
expert about the
problem.

Is Host print transform
(HPT) enabled?

Is Activate diagnostic
mode selected?

Test the print job.

Print output
satisfactory?

Done.

Are you using a
custom driver?

Contact
BOS

Technical
Support.

Is this an
orientation
 problem?

See the
Orientation

Problem
flowchart.

Is this a
character size

problem?

Is Normal
 print  selected?

You are printing to
a file, not to an
output printer.

Fix the diagnostic
mode setting.

Test the print job.

Print output
satisfactory?

Done.

Yes

Yes

Yes

Yes

Yes

Yes

No

No
No

No

No

No

No

Small
Characters or
Short Lines
flowchart.

Wrapping
Lines

flowchart.

Missing
Characters
(left side)
flowchart.

Missing
Characters
(right side)
flowchart.

Yes, What type?

Start Here
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Small Characters/Short Lines Flowchart
              

Continued…
              

From Main Flowchart.

Small Characters or
Short Lines Flowchart

Calculate the printed
CPI.

Decrease the CPI.

Test the print job.

Change the CPI setting to Host.

Print output
satisfactory?

Apply these
settings to all print jobs?

Characters larger,
but still too small?

Done.

Calculate the desired CPI
value (a value between the
original CPI from "Calculate
the printed CPI" and the
one you just tried).

Change the CPI translation
of the original CPI
(Calculate the printed CPI)
to the CPI you just
calculated.

Yes

Yes

No

No

No

Yes

p. 103

CPI or Font ID
control?

Change the
original font
translation

(from
previous job
attributes) to
the CPI value
of the latest
print output.

Font ID
control

Change the CPI translation of the original
CPI to the CPI value of the latest print

output.

Change the CPI
translation in small
intervals and test a
print job each time.

Print output
satisfactory?

CPI control

Done.

If you have tried
different CPI

values in small
intervals and are
still not satisfied
with the result,

collect
troubleshooting
information and
send it to BOS

Technical
Support.

No

Print output
satisfactory? No

Apply
these

 settings to
all print
jobs?

Change the
CPI setting

to Host.
Done.

Yes

No

Yes
Yes

Test the print job.
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Missing Characters Flowchart
              

Wrapping Lines Flowchart
              

Change the diagnostic
mode to Print preview.

Send the print job again.
It will appear in Print

preview.

Are characters
missing?

This indicates that the
problem is not in the
information that is sent
to the printer driver.

Verify (or correct) the
paper size, paper type,
or margins for your
Windows printer.

Test the print job.

Print output
satisfactory?

Done.

Change the printer driver
(to check whether the problem
is specific to this driver).

Print output
satisfactory?

The problem seems to be with the specific printer driver.
Collect troubleshooting information and send it to BOS
Technical Support, including this information about the

driver.

The problem is not
specific to this
printer driver.

Collect
troubleshooting
information and
send it to BOS
Technical Support,
including the
information about
the driver.

No

No
NoYes

Yes

From Main Flowchart.

Missing Characters
(left side) Flowchart

Missing Characters
(right side) Flowchart

This indicates that the print job
lines are too long and your

system doesn't wrap the long
lines. See Wrapping Lines

flowchart

Calculate the printed
CPI.

Increase the CPI.

Test the print job.

Print output
satisfactory?

Lines too
short?

Apply these
settings to all

print jobs?
Done.

Small
Characters or
Short Lines
flowchart,

p. 222.

Change the CPI setting
to Host.

CPI or Font
 ID control?

Change the
CPI

translation.

Change the
font

translation.

No

No

No

Yes

YesYes

CPI control Font ID control

From Main Flowchart.

Wrapping Lines
Flowchart
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Orientation Problem Flowchart
              

Continued…

              

From Main Flowchart.

Orientation Problem
Flowchart

Always prints in Landscape
mode even when set to

Portrait.

Continue with
Landscape problem

flowchart.

Orientation
changes

unexpectedly.

Always prints in Portrait
mode even when set to

Landscape.

Change the page
orientation setting to

Landscape.

Test the print job.

Print output
satisfactory?

Apply these
settings to all

print jobs?

Yes

Done.

Change the page
orientation setting to

Host.

Test the print job.

Yes

No

No

What type?

Contact BOS
Technical
Support

*  p o r t r a i t

T h e  p r in t e r  is  n o t
r e s p o n d in g  t o
t h e  la n d s c a p e

c o m m a n d  s e n t
b y  t h e  p r in t e r

s e s s io n .
C o n t in u e  w i t h

t h e  P r in t e r
R e s p o n s e
f lo w c h a r t .

P r in t  o u t p u t
s a t is f a c t o r y ?

W h a t  is
t h e  p a g e

r o t a t io n  a t t r i -
b u t e ?

N o

T e s t  a n o t h e r  p r in t  j o b
w i t h  t h is  s a m e
c o n f ig u r a t io n .

Y e s

T h is  in d ic a t e s  t h a t
t h e  h o s t  is

s e n d in g  t h e
p o r t r a i t  o r ie n t a t io n

c o m m a n d .
C o n t in u e  w i t h  t h e
P o r t r a i t  S o lu t io n s

f lo w c h a r t .

P o r t r a i t

T h is  c o u ld
b e  a  C P I
p r o b le m .
C o n t in u e
w i t h  t h e

C P I
f lo w c h a r t .

W h a t  is  t h e
p a g e  r o t a t io n

a t t r ib u t e ?

T h is  is  t h e
e m u la t io n 's

d e f a u l t  s e t t in g .
T h is  in d ic a t e s

t h a t  n o
o r ie n t a t io n
c o m m a n d

a r r iv e d  f r o m  t h e
h o s t .

A s k  y o u r  iS e r ie s
e x p e r t  t o  c h e c k
t h e  h o s t  p r in t in g

c o n f ig u r a t io n .

T h is  in d ic a t e s
t h a t  t h e  p r in t e r

e m u la t io n
r o t a t e d  t h e  p a g e
t o  L a n d s c a p e  t o

f i t  a l l  t h e
c h a r a c t e r s  o n

t h e  p a g e .

*  P o r t r a i t
A u t o

P r in t  o u t p u t
s a t is f a c t o r y ?

N o

D o n e .
Y e s

T h is  in d ic a t e s  t h a t  t h e
h o s t  is  s e n d in g  t h e

L a n d s c a p e  o r ie n t a t io n
c o m m a n d .

A s k  y o u r  iS e r ie s  e x p e r t
t o  c h a n g e  t h e  o r ie n t a t io n

s e t t in g  in  t h e  h o s t
a p p l ic a t io n  o r  t h e  h o s t

p r in t  f i le  t o  P o r t r a i t .

L a n d s c a p e

I n c r e a s e  t h e  C P I .

C o n t in u e  w i t h  t h e
W r a p p in g  L in e s

f lo w c h a r t .

T h is  is  t h e
e m u la t io n 's

d e f a u l t  s e t t in g
a n d  in d ic a t e s  t h a t

n o  o r ie n t a t io n
c o m m a n d  a r r iv e d

f r o m  t h e  h o s t .
C h a n g e  t h e

o r ie n t a t io n  s e t t in g
t o  C O R .

*  P o r t r a i t A u t o
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Landscape Problem Flowchart
              

Continued…
              

From
Orientation Problem Flowchart.

Landscape Problem Flowchart

Always prints in Landscape mode
even when set to Portrait.

Verify that the page orientation is set
to Host.

Apply to all print
jobs? Test the print job.No

Print output
satisfactory?

Test all relevant print
jobs.

If all the results are
satisfactory, you are
done. If not, continue

with Step A.

Yes

What is the page
rotation attribute?

Step A

No

Change the page orientation
setting to Portrait.

Test the print job.

Print output
satisfactory? Done.Yes

The printer is not responding to
the Portrait command sent by

the printer session.

Continue with the Printer
Response flowchart, p. 231.

No

This indicates that the
host is sending the

Landscape orientation
command.

Ask your iSeries expert
to change the orientation

setting in the host
application or the host

print file to Portrait.

Landscape

Change the page orientation
setting to Portrait.

Portrait or *Portrait

Test the print job.

Print output
satisfactory?

The printer is not responding to
the Portrait command sent by the

printer session.

Continue with the Printer
Response flowchart.

Step B

No
Change the page

orientation setting to
Host.

Yes

Test all relevant print
jobs.

If all the results are
satisfactory, you are
done. If not, continue

with Step B.

What is the Page
orientation attribute?

Auto

This indicates that the
printer session is

sending the Landscape
orientation command as
a result of an automatic

calculation.

Landscape

Change the CPI setting
to 20.

Portrait

Portrait

Yes

Test the print job.

What is the page
orientation attribute?

Portrait

Printed in
Portrait?

No

Character size
satisfactory?

Test all relevant print jobs.

If all the results are
satisfactory, you are done.
If not, continue from Step

C.

Change the CPI.

Remember: Larger CPI value = smaller
character size.

Continue with the Small Characters/Short
Lines flowchart.

Step C

Try the following
possible solutions.

Landscape

Change the diagnostic
mode to Save the

EBCDIC File.

Collect troubleshooting
information and send it

to BOS Technical
Support.

Yes

No

Yes
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CPI Problem Flowchart
              

Printer Response Problem Flowchart
              

From
Orientation Problem Flowchart.

CPI Problem Flowchart

Note the CPI setting and then change the CPI
setting to 10, 12, 15 and 20 (try one at a time).

Test the print job.

Printed in
Landscape?

Contact BOS
Technical Support

No

CPI or Font ID
control?

Yes

Note the Font ID value.

Font ID control

Note the CPI value.

CPI control

Is this CPI
used only for this

print job? (ask your
BOSaNOVA Web

administrator).

Is this font
used for this

print job?  (ask your
BOSaNOVA Web

administrator).

The printer session is
unable to differentiate
between different print
jobs that are using the
same CPI or Font ID.

No

No

Change the original CPI
translation to the larger

CPI value you set
previously.

Yes

Change the original font
translation to CPI value

you used previously.

Yes

Try the following
possible solutions:

Ask your Jadvantage
administrator to assign a

unique CPI or Font ID
value to each host print

file.

Change the diagnostic
mode to save the EBCDIC

File.
Collect troubleshooting

information and send it to
BOS Technical Support.

Possible solutions

Printed in
Landscape?

This indicates that
the problem is in the

interface between
the printer session

and the printer driver
(that is, in the

driver's receiving of
the command).

Possible solutions

This indicates that
the problem is in the

interface between
the printer driver and
the printer (that is, in
the driver's sending

of the commands) or
in the printer itself.

Contact the printer supplier and get a
new driver compatible with the Windows

version you are using.

Try using a BOS custom driver.

Check the printer.

If you have tried the different possible solutions and are
still not satisfied with the result, collect troubleshooting

information and send it to BOS Technical Support.

Check that the correct printer driver is selected.

Open any Windows application (e.g., Notepad,
Wordpad) and send a printout in Portrait orientation.

Note whether the output prints
in Portrait orientation.

In the same Windows application, change the orientation
setting to Landscape and send the same printout again.

From
Orientation Problem Flowchart

Printer Response Flowchart

The printer is not responding to the Landscape
command send by the printer session.

Yes No
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Portrait Solutions Problem Flowchart
              

Solutions for General Printing Emulation Prob-
lems

Slow Printing 

Using a custom driver is generally faster than printing 
through Windows functions:
1. From the printer session, open Printer Session Prop-

erties.
2. In the General tab, select Custom driver.
3. Select a suitable printer from the dropdown list.

No Printout 

There is no output from the printer, even when you click 
Print Test Page in the General tab of Printer Session 
Properties.
Try the following:
1. If Diagnostic Mode is active, turn it off (in Printer Ses-

sion Properties > Diagnostics tab, make sure that 
Activate diagnostics mode is not selected). Try 
printing again.

2. In the General tab, make sure that Current Windows 
driver is selected. Make sure that the driver is cor-
rectly defined in the Windows Control Panel (that is, 
you are trying to print to the correct printer).

From
Orientation Problem Flowchart.

Portrait Solutions Flowchart

The host is sending the portrait
orientation command, but the emulation

is printing in Landscape.

Try one of the following possible
solutions:

Ask your BOSâNOVA Web
administrator if it is possible

to create separate printer
sessions for the print jobs

that must be printed in
Landscape and in Portrait

orientation.

Create a new printer session
for Landscape jobs.

Change the parameter
control setting to

Automatic control CPI
priority.

Change the orientation
setting to COR.

Ask your BOSâNOVA
Web administrator if it is
possible to change the
host application to send
this specific print job in
Landscape orientation.

Set the page orientation
setting to Landscape.

Done.

Test the print job.

Done.

Print output
satisfactory?

Yes

Test the print job.

Print output
satisfactory?

Test another print job with this
same configuration.

Yes

Print output
satisfactory?

Done.

Yes

If you have tried the
different possible

solutions and are still not
satisfied with the result,
collect troubleshooting
information and send it

to BOS Technical
Support.

No

No

No
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3. Select to see if there is enough disk space available 
on the disk where the Windows Spool folder is 
located.

4. Try to print from another Windows application, such as 
WordPad. If nothing prints out, this may indicate a 
Windows problem. In this case, contact Microsoft 
Technical Support.

5. Check the Printer Session Status screen:
a. If Device Status > Host device status is Not 

Available, ask your BOSâNOVA Web 
administrator to check the system configuration 
(for example, is the IP address correct? is the 
iSeries TCP/IP interface activated?).

b. If Device Status > Host device status is Available, 
but Job Status > Status is Idle, check that the print 
job was sent to the correct printer output queue.

c. If Device Status > Host device status is Available, 
Job Status > Status rotates from Idle to Spooling 
to Printing, and Job Status > Bytes received is 
greater than zero (0), the problem is in the printer 
configuration.

Zero Bytes

If no printout appears, and the job status entry in the 
printer session shows 0 bytes received, perform the fol-
lowing:
1. Check that the writer you are using in the host is 

already started.
2. Make sure that there are no messages in your print 

job or in the writer and that the print file is ready (not in 
HLD status). Run the following command: WRKOUTQ 
<prtdevname>

3. Press <5> and look for the switch setting (physical 
address). Make sure that the port number is the same 
station to which you are connected.

4. If you are using an APPC connection, make sure that 
the printer to which you send your printouts is the 
same as the session name defined in the BOSâNOVA 
Web Configurator.

5. Check that the device type is the same as that defined 
in the BOSâNOVA Web Configurator by running the 
following command on the command line: WRKDEVD 
<prtdevname>

6. If it’s not the same, end the writer in the host 
(ENDWTR <prtname>), change it, and restart the 
emulation.

7. If this doesn’t help, define your printer device manually 
(using the CHGDEVD or CRTDEVD commands).
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8. Check in WRKCFGSTS *DEV <prtdevname> that 
your printer is Varied on. If the status is Varied off or 
Failed:
a. Vary off the device.
b. Vary on the device.
c. Start the printer writer (STRPRTWTR <prt 

name>).

Printout Doesn’t Fit on the Page

If the printer emulation is using the correct CPI and LPI as 
defined in the host, but doesn’t fit on the page, perform 
these steps:
1. Open Printer Session Properties.
2. In the Page Setup tab, set Parameter Control to Auto-

matic Control.

NOTE:  This means that the PC emulation, not the host, will control 
CPI and LPI.

3. Check to make sure that your physical paper size and 
source (tray) match the settings. Paper size is defined 
in the Page Setup tab, under Paper source and size:
a. If you are using the Windows driver: If Paper 

source and size is set to Set At, make sure the 

correct item is selected from the dropdown list, or 
use Default Paper Size and Source.

b. If you are using a custom driver: If Paper source 
and size is set to host, the host selects one of the 
available paper sizes defined in the printer driver. 
If the paper in the physical printer does not match 
that defined in the printer driver, you must use the 
Printer Driver Editor to define the new paper size 
for the current driver; the definitions are made 
under Page Definition.

4. If you are not successful with Automatic, try specifi-
cally defining the CPI, LPI, and orientation (in the 
Page Setup tab > Parameter Control) for the print job.

80-column Output Doesn’t Fit on the Page

Your printout may not fit onto the page with the selected 
CPI, but using the next available CPI produces output that 
is too small. You can resolve this problem by creating an 
“in-between” CPI.
If you are using the Windows printer driver:

1. Right-click the  icon in the task bar.
2. Select Properties to open Printer Session Properties.
3. In the Page Setup tab, expand Advanced settings 

and select CPI translation in the top pane.
4. In the bottom pane, click the Add button.
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5. In Add New CPI, create a new CPI (for example, if the 
host CPI is 10, and the previous options were 10 or 
12, try 10.5 or 11).

6. Click OK.
If you are using a custom printer driver:
1. Open the Printer Driver Editor.
2. In Font Sets, add a new font definition. Enter the 

desired CPI and provide the select sequence. Provide 
a Host Font ID for at least one of the font attributes 
(regular, bold, italic, or bold+italic).

3. In Character Pitch, add your new CPI to host CPI and 
assign it to the new font.

4. When you re-enter the printer emulation, session, 
printer session properties, the new CPI should appear 
in CPI > Set At in Parameter Control.

Character Size Not Right 

If you are using the Windows printer driver:

1. Right-click the  icon in the task bar.
2. Select Properties to open Printer Session Properties.
3. In the Page Setup tab, set Parameter Control to 

Manual Control.
4. Set CPI to Set At and make sure the required CPI 

exists. If it does, select it and go to step 6. To define a 
new CPI, continue with step 5.

5. Define a new CPI:

NOTE:  This step is for printer models 3812 and 5219 only.

a. Select Advanced Settings and select CPI 
Translation.

b. Click the Add button.
c. Complete the fields in Add New CPI and click OK.
d. (Optional) To change the Host Font ID as well, 

select Font Translation (in Advanced Settings) 
and click the Add button.

e. Complete the fields in Add New Font and click 
OK.

f. Now that the desired CPI has been defined, return 
to Parameter Control, set CPI to Set At, and 
select the CPI you just added.

6. Release the print job (or re-send) to test the output. If 
the CPI appears OK, you are done for this job. If you 
have other print jobs requiring a different CPI, go on to 
step 7.

7. This step enables the host to define CPI settings auto-
matically; this is convenient if you have print jobs that 
require different CPIs:
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NOTE:  This step is for printer models 3812 and 5219 only.

a. Return to Parameter Control and select Manual 
Control.

b. Change CPI to Host.
c. Change Orientation to Portrait or Landscape, 

depending on your requirements.
d. Release the print job (or re-send) to test the 

output. If the output is OK this time, you are done. 
If not, or if you need to change the orientation 
depending on the print job, go on to step e).

e. Change Orientation back to Host. Define the 
orientation for each job on the host side. Make 
sure Rotation is not set to *Auto at the host side 
(You can see what the current setting is by looking 
in Previous Job Attributes in Printer Session 
Properties).

If you are using a custom printer driver:
1. Make sure that the defined driver is suitable for your 

PC printer and its mode (Epson, IBM ProPrinter, HP, 
etc.).

2. Open Printer Session Properties.
3. In the Page Setup tab, set Parameter Control to 

Manual Control.

4. Set CPI to Set At and make sure the required CPI 
exists. If so, select it and go to step 6. To define a new 
CPI, continue with step 5.

5. Define the CPI by using the Printer Driver Editor; the 
definitions are made under Character Pitch and Font 
Sets:

6. When you are done, close the Printer Driver Editor 
and return to Printer Sessions Properties.

7. Set CPI to Set At, and select the CPI you just added.
8. Release the print job (or re-send) to test the output. If 

the CPI appears OK, you are done for this job. If you 
have other print jobs requiring a different CPI, con-
tinue with step 7.

9. This step enables the host to define CPI settings auto-
matically; this is convenient if you have print jobs that 
require different CPIs:

NOTE:  This step is for printer models 3812 and 5219 only.

a. Return to Parameter Control and select Manual 
Control.

b. Change CPI to Host.
c. Change Orientation to Portrait or Landscape, 

depending on your requirements.
d. Release the print job (or re-send) to test the 

output. If the output is OK this time, you are done. 
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If not, or if you need to change the orientation 
depending on the print job, continue with step e).

e. Change Orientation back to Host. Define the 
orientation for each job on the host side. Make 
sure Rotation is not set to *Auto.

Error Messages

If you receive any of these errors, or any other error which 
does not provide you with enough information to correct 
the problem, contact BOS Technical Support.

JDTF Troubleshooting

If you received an error for which there is not enough 
information below to correct the problem, contact your 
BOSâNOVA Web administrator.   

Error
Cause
Action

Exception occurred while opening database.

Internal error.

Shut down and restart the system.

Error
Cause
Action

System error.

Internal error.

Shut down and restart the system.
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Error
Cause
Action

Socket I/O error.

Internal error.

Shut down and restart the system.

Error

Cause

Failed to get the port number of the database 
server on the specified host. Check that the data-
base server is running. Use the command STRHO-
STSVR *DATABASE to run the database server.

The cause and action are described in the body of 
the message.

Error

Cause
Action 1
Action 2

Security verification failed (primary RC = number, 
secondary RC = number).

Possible error in user ID or password.

Try re-entering both.

Contact the BOSâNOVA Web administrator.

Error
Cause

Cannot connect to host name, port #number.

Either the name or the IP address of the host is 
wrong.

Action
Cause

Contact the BOSâNOVA Web administrator.

Port number is wrong.

Action
Error

Contact the BOSâNOVA Web administrator.

I/O exception occurred while connecting to host: 
name.

Cause

Action

Problem with the communication between the PC 
and the host.

Contact the BOSâNOVA Web administrator.

Error
Cause
Action 1
Action 2

Unknown optional parameter received: name.

Internal error.

Restart the system.

Uninstall and reinstall BOSâNOVA Web.

Error
Cause
Action 

Unknown field type: name.

Internal error.

Restart the system.
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Error
Cause
Action

Communication was interrupted.

Problem with the communication between the PC 
and the host.

Try connecting again. If the problem repeats, con-
tact the BOSâNOVA Web administrator.

Error

Cause

The host library either was not specified or does 
not exist. Verify the location of the host library (or 
reference library) and try again.

Cause and action described in the body of the mes-
sage.

Error

Cause

The host library/file either was not specified or does 
not exist. Verify the location of the host library/file 
and try again.

Cause and action described in the body of the mes-
sage.

Error

Cause
Action

The host sent the following message: message 
(primary return code: number, secondary return 
code number).

Indicated by the host’s message.

Depends on the host’s message.

Error

Cause

No data was found to match your request. Check 
that all host names (libraries, files, members, field, 
etc.) used in your request are spelled correctly and 
try again.

Cause and action described in the body of the mes-
sage.

Error

Cause

A variable-length host field was found during 
upload: variable-length host fields are supported for 
download only. Change the host file you want to 
upload.

Cause and action described in the body of the mes-
sage.

Error

Cause

Unable to convert the field value for field number in 
record number. Try again with a different host file.

Cause and action described in the body of the mes-
sage.

Error

Cause

For Plain or Source transfer, only one host file is 
allowed. Remove extra files from the host location.

Cause and action described in the body of the mes-
sage.
    
Previous Page Contents 116 Index Next Page



BOSâNOVA Web User Guide
Error

Cause

If transfer type is Source, the host location must 
include only the source host file. Choose another 
host file.

Cause and action described in the body of the mes-
sage.

Error

Cause

Action

Number of fields in line #number is not equal to the 
number of fields in the host file.

The structure of the PC file doesn’t match the struc-
ture of the host file.

Fix the PC file.

Error
Cause
Action

Cannot convert field #number in line #number.

The structure of the PC file doesn’t match the struc-
ture of the host file.

Fix the PC file.

Error

Cause

Unable to create a member with the name 
‘*FIRST’. Change the member name.

Cause and action described in the body of the mes-
sage.

Error

Cause
Action

Host file specified consists of more than one field, 
therefore Plain transfer is impossible.

Described in the body of the message.

Change transfer type to Database or use another 
file.

Error

Cause
Action

Reference file specified consists of more than one 
field, therefore Plain transfer is impossible. 

Described in the body of the message.

Change transfer type to Database or use another 
file.

Error
Cause
Action

Exception name occurred.

Depends upon exception.

Try again; if problem recurs, call BOS Technical 
Support.

Error
Cause
Action

Wrong line in file.

PC file structure does not conform to the host file 
structure.

Fix the PC file or try a different PC file.
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Error
Cause
Action

Parameter name is invalid. Correct it.

A specific profile parameter is wrong.

Fix the parameter.

Error

Cause

The host member either was not specified or does 
not exist. Verify the location of the host member 
and try again.

Cause and action described in the body of the mes-
sage.

Error
Cause
Action

The client CCSID number is not supported by the 
host.

Described in the body of the message.

Choose another host.

Error

Cause

Host library/file either does not exist or contains no 
member. Verify the location of the host library/file 
and try again.

Cause and action described in the body of the mes-
sage.

Error
Cause
Action

Unable to connect to host name. JDTF will work 
offline.

Unable to establish connection with the host.

Contact the BOSâNOVA Web administrator.

Error
Cause
Action

Unable to preview for specified transfer type.

Profile is damaged.

Remove the profile and create a new one.

Error
Cause
Action

Host name doesn’t support code page number 
defined in the profile.

As described in the body of the message.

Specify the correct code page or choose another 
host.

Error
Cause
Action

Host EBCDIC code page number is not supported.

As described in the body of the message.

Specify the correct code page or choose another 
host.
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Error
Cause

Action

Host name specified in the profile is unknown.

Host specified in the profile doesn’t exist in the list 
of available hosts.

Choose an existing host.

Error
Cause
Action

Failed to connect to HTTP server.

HTTP server is down.

Contact the BOSâNOVA Web administrator.

Error
Cause 1
Cause 2
Action

Unable to retrieve the profiles for the current user.

The current user does not have permission to use 
JDTF.

No profiles are assigned to this user.

Contact the BOSâNOVA Web administrator.

Error

Cause
Action

Unable to open the profile because the name entry 
either is invalid or was not specified in the profile.

Profile is damaged.

Remove the profile and create a new one.

Error

Cause

The entry name either could not be read from the 
profile or is invalid. The default value will be used.

Cause and action described in the body of the mes-
sage.

Error
Cause
Action

I/O error occurred while saving the profile.

Problem with the proxy server.

Contact the BOSâNOVA Web administrator.

Error
Cause
Action

I/O error occurred while removing the profile.

Problem with the proxy server.

Contact the BOSâNOVA Web administrator.

Error
Cause
Action

I/O error occurred while retrieving the profile.

Problem with the proxy server.

Contact the BOSâNOVA Web administrator.
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Display Emulation Troubleshooting

If you received an error for which there is not enough 
information below to correct the problem, contact your 
BOSâNOVA Web administrator.

Login Troubleshooting

If you received an error for which there is not enough 
information below to correct the problem, contact your 
BOSâNOVA Web administrator.

Error
Cause
Action

Unable to establish connection with the proxy 
server.

Proxy server is down.

Contact the BOSâNOVA Web administrator.

Error
Cause
Action

Failed to receive server replay.

Proxy server is down.

Contact the BOSâNOVA Web administrator.

Error
Cause

Read operation failed. The failure details follow.

Cause and action are described in the body of the 
message.

Error
Cause
Action

File name file was not saved (file writing error).

Server is not able to save the file.

Try again. If problem recurs, contact your 
BOSâNOVA Web administrator.

Error
Cause
Action

Unable to delete file filename.
Server is not able to delete the file.

Try again. If problem recurs, contact your 
BOSâNOVA Web administrator.

Error
Cause
Action

Unable to delete directory name.

Server is not able to delete the directory.

Try again. If problem persists, contact your 
BOSâNOVA Web administrator.

Error
Cause
Action

All fields must be filled in.

Either the Username or Password field was not 
filled in.

Enter the relevant information.
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Error
Cause
Action

User does not exist.

The name in the username field is not a configured 
user.

Either correct the name, enter another name, or 
contact your BOSâNOVA Web administrator.

Error
Cause
Action

Incorrect password.

The password was not entered correctly.

Either correct the password or contact your 
BOSâNOVA Web administrator.

Error
Cause

Action

Wrong connection type.

There are three connection types: non-secure, 
SSL, and SSL with Client Certificate Authentica-
tion. You were assigned one of these but are trying 
to connect using the wrong connection type.

Select the correct type and try again. If the problem 
persists, contact your BOSâNOVA Web administra-
tor.

Error

Cause

Action

You can only connect to the BOSâNOVA Web 
server via SSL. You are trying to create a non-SSL 
connection.

Your configuration restricts you to a secure connec-
tion via SSL. You attempted to connect without 
security.

Try again with SSL. If the problem recurs when try-
ing with SSL, contact your BOSâNOVA Web 
administrator.

Error

Cause

Action

You can only connect to the BOSâNOVA Web 
server via SSL with Client Certificate Authentica-
tion. You are either trying to create a non-SSL con-
nection or your certificate is invalid.

Your configuration restricts you to a secure connec-
tion via SSL with valid Client Certificate Authentica-
tion. You attempted to connect without security.

Try again with valid Client Certificate Authentica-
tion. If the problem recurs, contact your 
BOSâNOVA Web administrator.

Error
Cause
Action

System not available.

Unable to establish communication with the host.

Contact your BOSâNOVA Web administrator.
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User Configurator Troubleshooting

If you received an error for which there is not enough 
information below to correct the problem, contact your 
BOSâNOVA Web administrator.

Error
Cause
Action

Servers.jtn file is not available.

Servers.jtn file may be corrupted.

Contact your BOSâNOVA Web administrator.

Error
Cause
Action

Wrong code page defined.

As defined in the message.

Define the correct code page.

Error
Cause
Action

No sessions….

The BOSâNOVA Web administrator has not 
assigned any sessions to this user.

Contact the BOSâNOVA Web administrator.

Error
Cause

Action

No Autorun session defined…

You’ve selected Run default session but have no 
Autorun session defined.

Either clear Run default session and log in again, 
or define an Autorun session and log in again.

Error
Cause
Action

Unable to connect to the BOSâNOVA Web server.

Problem with the communication between the PC 
and the server.

Contact your BOSâNOVA Web administrator.

Error
Cause
Action

Proxy failed to save the profile.

Problem with the proxy server.

Contact the BOSâNOVA Web administrator.

Error
Cause
Action

Proxy failed to delete the profile.

Problem with the proxy server.

Contact the BOSâNOVA Web administrator.
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Error
Cause 1
Action 1
Cause 2
Action 2 

Failed to connect to the host specified because it is 
unknown.

Either the name or the IP address of the host is 
wrong.

Check the IP address and host name.

Port number is wrong.

Contact the BOSâNOVA Web administrator.

Error
Cause 1
Action 1
Cause 2
Action 2

Failed to connect to the host specified because of 
unknown route.

Either the name or the IP address of the host is 
wrong.

Check the IP address and host name.

Port number is wrong.

Contact your BOSâNOVA Web administrator.

Error
Cause
Action

Host refused to connect.

Unable to establish connection with the host.

Try again. If the problem recurs, contact the 
BOSâNOVA Web administrator.

Error
Cause
Action

An I/O exception occurred on the proxy server.

Proxy problem.

Contact the BOSâNOVA Web administrator.

Error

Cause
Action

No sessions were defined by the BOSâNOVA Web 
administrator for this user. Access denied.

As described in the body of the message.

Contact the BOSâNOVA Web administrator.

Error
Cause
Action

Groups directory not found.

Directory might be corrupted.

Contact your BOSâNOVA Web administrator.

Error
Cause
Action

Users directory not found.

Directory might be corrupted.

Contact your BOSâNOVA Web administrator.
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Error
Cause
Action

User doesn’t exist. Check the username or enter a 
different name.

The name in the username field is not a configured 
user.

As described in the body of the message.

Error
Cause
Action

User does not exist.

The name in the username field is not a configured 
user.

Either correct the name, enter another name, or 
contact your BOSâNOVA Web administrator.

Error
Cause
Action

Cannot save file (file writing error).

Server is not able to save the file.

Try again. If the problem recurs, contact your 
BOSâNOVA Web administrator.

Error
Cause
Action

The System.jtn file is missing.

File may be corrupted.

Contact your BOSâNOVA Web administrator.

Error
Cause

Action

Wrong connection type.

There are three connection types: non-secure, 
SSL, and SSL with Client Certificate Authentica-
tion. You were assigned one of these but are trying 
to connect using the wrong connection type.

Select the correct type and try again. If the problem 
persists, contact your BOSâNOVA Web administra-
tor.

Error
Cause
Action

Incorrect password.

The password was not entered correctly.

Either correct the password or contact your 
BOSâNOVA Web administrator.

Error
Cause
Action

Access is not allowed.

Permission for this has not been assigned.

Request permission from your BOSâNOVA Web 
administrator.
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Macro Editor Troubleshooting

If you received an error for which there is not enough 
information below to correct the problem, contact your 
BOSâNOVA Web administrator.

Keyboard Mapping Troubleshooting

If you received an error for which there is not enough 
information below to correct the problem, contact your 
BOSâNOVA Web administrator.

Error
Cause
Action

The macro name is too long.

The macro name can’t be longer than 32 charac-
ters.

Enter a shorter macro name.

Error

Cause
Action

Unable to continue recording the macro; the maxi-
mum number of operations has been reached.

A macro can’t be longer than 35 operations.

Record the macro as two separate macros.

Error
Cause
Action

Macro name name of macro already exists.

As defined in the body of the message.

Enter a different name.

Error This key cannot be remapped.

Cause Certain keys cannot be changed, including Ctrl, 
Caps Lock, and Num Lock.

Action Create the mapping based on a different key.
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Uninstalling 

The procedure for uninstalling BOSâNOVA Web 6.x (Java 
2) depends on the Java version, not on the browser or 
platform.

Uninstall for Java 1.4x

To uninstall BOSâNOVA Web 6.x for Java 1.4.x:
1. Close all open browser windows.
2. Select Start > Settings > Control Panel.
3. Click the Java icon.  Depending upon Java version, 

the icon may be titled Java Plug-in.  
4. Select the Cache tab.
5. Click Clear.  This will clear all of the Java Plug-in 

cache, including the BOSâNOVA Web JAR.

NOTE:  To remove only the BOSâNOVA Web applet, or to see the 
current content of the cache, click View.  The BOSâNOVA Web 
client is listed by the name <server URL>\BOSâNOVA Web.jar or 
<server URL>\BOSâNOVA WebSSL.jar.

6. Click Yes at the confirmation message.

Uninstall for Java 1.5x

To uninstall BOSâNOVA Web 6.x for Java 1.5.x:
1. Close all open browser windows.
2. Select Start > Settings > Control Panel.
3. Click the Java icon.  Depending upon Java version, 

the icon may be titled Java Plug-in.  
4. Select the General tab.
5. Click Delete Files.  The Delete Temporary Files 

window is displayed.
6. Clear all the checkboxes.
7. Select Downloaded Applets and click OK.  This will 

clear all of the Java Plug-in cache, including the 
BOSâNOVA Web JAR.
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Uninstall for BOSâNOVA Web 4.x

The procedure for uninstalling differs per web browser.  To 
completely remove BOSâNOVA Web 4.x (Java 1.1) from 
your PC, follow the appropriate procedure.

Microsoft Explorer

1. From the Tools > View menu, select Internet 
Options.

2. Select the General tab.
3. Click Settings. The Settings screen opens.
4. Click View Objects.  A list of installed components is 

displayed.
5. Select BOSâNOVA Web.
6. Right-click, and select Remove.   BOSâNOVA Web is 

completely removed from your PC.
7. Close the list and click OK twice to return to your 

browser’s main screen.

Netscape Navigator

1. From the Edit menu, select Preferences.  The Prefer-
ences screen opens.

2. Under Category, click Navigator.
3. Click Applications in the Navigator screen.  A list of 

installed components is displayed.

4. Select BOSâNOVA Web from the Description list.
5. Click Remove.  BOSâNOVA Web is completely 

removed from your PC.
6. Close to return to your browser’s main screen.

If uninstalling from Netscape Navigator 6:
1. Select Start > Settings > Control Panel > Java 

Plug-in.
2. Click Cache.
3. Click Clear JAR Cache.  This will clear all the JARs 

for your Java Plug-in, including the BOSâNOVA Web 
JAR.
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Host Print 
Transform

This appendix describes Host Print Transform and how to 
work with it.
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Host Print Transform

Host Print Transform is an iSeries process that enables 
you to use an ASCII printer as an iSeries system printer. It 
does this by transforming a print job that was originally 
written in EBCDIC code into an ASCII data stream that 
contains both the print job data and the printer com-
mands. This feature is integrated into the iSeries from 
Version 3 Release 1.

Understanding Host Print Transform 

When Host Print Transform is used, BOSâNOVA Web 
provides a physical connection to the printer, but does not 
control any printer commands. Host Print Transform 
works with all emulation products that support the “ASCII 
Transparent” command.
When printing an SCS spooled file through Host Print 
Transform, the writer takes data from the spooled file and 
sends it to Host Print Transform, which then returns an 
ASCII data stream. This data stream is then wrapped in 
ASCII Transparent commands and sent to BOSâNOVA 
Web.
The BOSâNOVA Web printer emulation removes the 
ASCII Transparent commands and sends the ASCII data 
stream to the printer without translating the data stream. 

When using Host Print Transform, the EBCDIC-to-ASCII 
transform takes place in the iSeries printer writer’s pro-
cess. This means that your spooled files are still stored in 
EBCDIC format on the iSeries.
For more information, see the IBM publication, “Applica-
tion System/400: Setting Up and Printing in an OfficeVi-
sion/400 Environment,” document number SH21-0511-00.

Using Host Print Transform

Since the transform is performed on the iSeries, Host 
Print Transform (HPT) uses more iSeries system 
resources and has a greater effect on system perfor-
mance than non-HPT printing. System performance will 
be affected depending on the number of printers using 
Host Print Transform, the number of files being sent to 
these printers, the type and model of your system, and 
other factors.
On the other hand, Host Print Transform means the 
printing process and printing configuration are controlled 
by the host; that is, settings can’t be changed in the 
printer emulation session. If you want control of your 
printing configuration, you must first disable Host Print 
Transform.
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Windows vs. 
Custom Driver

This appendix compares printing with the Windows printer 
driver to printing with custom drivers. 
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Windows vs. Custom Driver

When BOSâNOVA Web uses the Windows printer driver 
to prepare a print job, it takes advantage of Windows GDI 
and usually prints in graphics mode. While this is slower 
than text mode, it is the most common way to print from 
Windows applications, and is certainly the simplest and 
most trouble-free.

Custom drivers provide faster performance because the 
data is sent directly to the printer, bypassing Windows 
processing (that is, they don’t use Windows GDI func-
tions). When using a custom driver, BOSâNOVA Web 
uses text mode and prepares the print job to include all of 
the escape sequences of the current printer. The obvious 
drawback of using custom drivers is that some expertise 
is required to make any changes to them, and once 
changes are made (through the Printer Driver Editor), the 
driver becomes harder to troubleshoot. Note that 
BOSâNOVA Web provides over 30 printer drivers to 
choose from; when a driver is used unmodified, it is gen-
erally trouble-free.

Windows vs. Custom Driver

To decide whether to use the default Windows driver or a 
custom driver, you must understand how BOSâNOVA 
Web handles print jobs.

Using a Custom Driver

When using the Windows driver, a data buffer (ASCII or 
EBCDIC) arrives at the Windows driver. It is then output 
as a graphics buffer to the printer queue. Each output 
buffer is approximately 40K.
When using a custom driver, a data buffer arrives at the 
custom driver. It is then output as the same strings (ASCII 
or EBCDIC) plus commands for that printer driver. This 
output is then routed to the Windows driver, where it again 
is output to the printer queue as data strings plus printer 
commands. Because no graphic processing is involved, 
each buffer is approximately 3K.
If you are printing straight ASCII text, for example, and 
require speed and high throughput, you might consider 
using a custom driver. Custom drivers can be modified 
using the Printer Driver Editor.
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Side-by-Side Comparison 

Here are some side-by-side comparisons to help you 
decide whether to use the Windows driver or a custom 
driver:

Selecting or Modifying a Custom Driver

BOSâNOVA Web provides over 30 custom printer drivers 
that bypass Windows processing (that is, they don’t use 
Windows GDI functions) and use text mode. Custom 
drivers provide faster performance than the standard Win-
dows printer driver because the data is sent directly to the 
printer.

Selecting a Custom Driver

1. Right-click the  icon in the task bar.
2. Select Properties to open Printer Session Properties.
3. Select the General tab.
4. Select Custom driver.
5. From the dropdown list, select a printer.
6. Click Select Printer.

Modifying a Custom Driver

Some expertise is required to make any changes to 
custom drivers, and once changes are made, the driver 
becomes harder to troubleshoot.

NOTE:  For details on modifying a custom driver, see Printer Driver 
Editor Online Help or contact BOS Technical Support.

Table 6: Driver Comparison

Windows Custom

Usually prepares graph-
ics-mode printing.

Text mode; faster than 
graphics mode.

Uses a standard, Win-
dows-supplied driver for 
each printer.

Users must have their 
own driver or define the 
printer using the Printer 
Driver Editor.

Does not support non-
standard printing macros 
or bar-codes.

Supports non-standard 
printing macros and bar-
codes.

Does not support ASCII 
Transparent printing.

Supports ASCII Trans-
parent printing.

Uses fonts from Windows 
and from the printer 
driver.

Uses printer fonts only 
(such as cartridge-loaded 
printer fonts).
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Index and 
Navigation Tips

This section contains:  
• “Using the Index” on page 134
• “Links to Index Headings” on page 134
• “Navigation Tips” on page 134
• “Index” on page 135
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Using the Index

All entries in this index are links.  Place the cursor over 
any page number and the cursor will turn into a hand, sim-
ilar to this:  

                        

Click the page number of the index entry and the focus 
will jump to the designated area of the document.

Links to Index Headings

Use this table of Links to Index Headings to jump to 
entries beginning with a specific letter of the alphabet.   

Navigation Tips

The following tips simplify navigation:  
• To “turn the page” use either the right and 

left arrow keys or the up down arrow 
keys.    

• To display either the Table of Contents or 
the Index, click the links in the Navigation bar at the 
bottom of the page.

• All page numbers are links.  Place the cursor over 
any page number and the cursor will turn into a hand.  
Click any page number and the focus will jump to the 
designated area of the document.

• Click F4 to toggle Bookmarks in and out of view.  
• Bookmarks are links.  The cursor will turn into a 

hand.  Click and the focus will jump to the Bookmark 
entry.

• To open the Find dialog box, click Ctrl + F.  A B C D E

F G H I J

K L M N O

P Q R S T

U V W X Y

Z
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Index

Numerics
80-column output doesn’t fit on the page ....................111

A
activating diagnostic mode ...........................................96
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background image
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the printer driver .......................................................84
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calculating ............................................................... 91
changing translation ................................................ 93
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creating

JDTF profile ............................................................. 69
customizing MorphMaster. see MorphMaster
customizing the display emulation

toolbar ..................................................................... 30

D
defining user’s default sessions ................................... 16
deleting

display emulation macro .......................................... 42
diagnosing printing problems ..................................... 102
diagnostic mode ........................................................... 96

activating ................................................................. 96
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display emulation
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Previous Page Contents 135 Index Next Page



BOSâNOVA Web User Guide
attributes ..................................................................32
changing text & color attributes ................................32
copying & pasting .....................................................28
customizing the keyboard ........................................36
customizing the toolbar ............................................30
deleting a macro .......................................................42
display attributes ......................................................32
editing a macro .........................................................41
exporting display properties .....................................33
exporting/importing a macro .....................................42
features ....................................................................24
full-screen mode .......................................................30
macros .....................................................................39
menus ......................................................................25
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printing a screen .......................................................27
recording a macro ....................................................40
renaming a macro ....................................................42
saving workspace .....................................................27
showing/hiding the toolbar .......................................32
starting .....................................................................24
stopping ....................................................................27
test mode .................................................................26
toolbar ......................................................................30
troubleshooting .......................................................120
viewing a macro .......................................................41

duplicating a JDTF profile .............................................77

E
editing a display emulation macro ................................ 41
end of job settings ........................................................ 99
exclude ......................................................................... 46
exporting display emulation properties ........................ 33
exporting/importing display emulation macros ............. 42

F
font

fixed-width in subfile ................................................ 54
font identifiers ............................................................... 92
font translation, settings ............................................... 95
full screen mode ........................................................... 26

G
general tab ................................................................... 84
graphic formats ............................................................ 29
grouping range in MorphMaster ................................... 54

H
help request ................................................................. 12
Host Print Transform .................................................. 129

I
image ........................................................................... 29
importing/exporting user certificates .......................20, 21
Inserting ....................................................................... 35
inserting

background image ................................................... 35
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installing the Java applet ................................................7
installing the Spooler ......................................................8

J
Java applet installation ...................................................7
JDTF

assigning profiles .....................................................78
changing a profile list ...............................................76
creating a profile .......................................................69
creating a profile list .................................................76
duplicating a profile ..................................................77
introduction ...............................................................66
modifying a profile ....................................................77
previewing data before transfer ................................68
removing a profile .....................................................78
starting .....................................................................66
transferring data .......................................................68
transferring multiple profiles .....................................76
troubleshooting .......................................................114
updating list of assigned profiles ..............................67
viewing profile properties .........................................77
working offline ..........................................................67

K
keyboard mapping ........................................................36

control keys ..............................................................37
creating ....................................................................37
editing .......................................................................37
removing ..................................................................38

troubleshooting ...................................................... 125
viewing .................................................................... 37

L
logging in .....................................................................7, 9

to the user configurator ........................................... 15

M
Macro Editor troubleshooting ..................................... 125
margin settings ............................................................. 99
modifying

a custom driver ...................................................... 132
JDTF profile ............................................................. 77

MorphMaster
color translation table .............................................. 50
configure to recognize uppercase letters ................ 57
customizing a background color .............................. 52
customizing color translation ................................... 53
customizing show number ....................................... 53
customizing the color of subfile elements ................ 54
customizing the design ............................................ 53
customizing the font ................................................ 52
customizing the message line ................................. 53
excluding elements from conversion ....................... 46
grouping range ........................................................ 54
multi-column menus ................................................ 57
opening customization dialog box ........................... 47
range allowed for menu numbers ............................ 57
rule base customization ........................................... 55
    
Previous Page Contents 137 Index Next Page



BOSâNOVA Web User Guide
selecting and deselecting .........................................45
style folder customization .........................................50

N
no printout ...................................................................109

O
old fashioned orientation ...............................................99
opening a printer session ..............................................82
orientation

changing settings .....................................................92
other printer emulation problems ................................103

P
page setup tab ..............................................................86
PC

uninstalling .............................................................127
picture ...........................................................................29
playing display emulation macro ...................................40
previewing

a print job .................................................................83
data transfer .............................................................68

previous job attributes tab .............................................86
printer association .........................................................11
printer emulation

changing the printer driver .......................................84
closing a session ......................................................82
collecting tech support info ............................... 97, 102
CPI vs. font ID control ..............................................93

custom drivers ....................................................... 131
custom vs. windows drivers ................................... 132
diagnostic mode ...................................................... 96
drawer settings ........................................................ 87
font identifiers .......................................................... 92
Host Print Transform ............................................. 129
introduction .............................................................. 81
modifying a custom driver ..................................... 132
opening a session ................................................... 82
overview flowchart ................................................... 81
page setup ............................................................... 87
parameter control settings ....................................... 87
previewing a print job .............................................. 83
selecting a custom driver ....................................... 132
session properties ................................................... 83
sessions .................................................................. 81
testing a printing configuration ................................ 96
troubleshooting flowcharts ..................................... 103
windows printer driver ........................................... 131

printer emulation session ............................................. 81
printer emulation troubleshooting

80-column output doesn't fit on the page .............. 111
character size ........................................................ 112
no printout ............................................................. 109
other problems ...................................................... 103
printout doesn’t fit on page .................................... 111
slow printing .......................................................... 109
zero bytes .............................................................. 110

printer session properties ............................................. 83
    
Previous Page Contents 138 Index Next Page



BOSâNOVA Web User Guide
advanced tab ............................................................99
diagnostic tab ...........................................................96
general tab ...............................................................84
page setup tab .........................................................86
previous job attributes tab ........................................86
viewing .....................................................................12

printing a screen ...........................................................27
printout doesn’t fit on the page ...................................111
properties ......................................................................12

R
recording a display emulation macro ............................40
removing a JDTF profile ...............................................78
removing a keyboard mapping .....................................38
renaming display emulation macro ...............................42
ruler ...............................................................................38
running

a JDTF profile ...........................................................68

S
saving workspace .........................................................27
selecting a custom driver ............................................132
showing/hiding the toolbar ............................................32
side-by-side comparison .............................................132
sign-on bypass ..............................................................17
slow printing ................................................................109
Spooler installation .........................................................8
SSL

user SSL certificates ................................................17

SSL certificates ............................................................ 17
exporting user certificates ..................................20, 21
importing user certificates ..................................20, 21
user SSL configuration wizard ................................. 18

starting
display emulation ..................................................... 24
JDTF ........................................................................ 66

stopping the display emulation ..................................... 27

T
test mode ..................................................................... 26
testing a printing configuration ..................................... 96
troubleshooting

display emulation ................................................... 120
JDTF ...................................................................... 114
keyboard mapping ................................................. 125
Macro Editor .......................................................... 125
printer emulation .............................................102, 103
user configurator ................................................... 122
user login ............................................................... 120

U
uninstalling ................................................................. 127
uninstalling from MS Explorer .................................... 127
uninstalling from Netscape Navigator ........................ 127
updating list of assigned JDTF profiles ........................ 67
user

login ........................................................................7, 9
login troubleshooting ............................................. 120
    
Previous Page Contents 139 Index Next Page



BOSâNOVA Web User Guide
password ..................................................................16
SSL certificates ........................................................17
SSL configuration wizard .........................................18

user configurator ...........................................................15
defining default sessions ..........................................16
sign-on bypass .........................................................17
troubleshooting .......................................................122

using a custom driver ..................................................131

V
viewing a display emulation macro ...............................41
viewing images .............................................................29
viewing JDTF profile properties ....................................77
viewing keyboard mapping ...........................................37
viewing session properties ............................................12

Z
zero bytes ...................................................................110
    
Previous Page Contents 140 Index Next Page


	Table of Contents
	Introduction
	Components of the BOSâNOVA Web System
	Features of the BOSâNOVA Web System

	Getting Started with BOSâNOVA Web
	Installing BOSâNOVA Web
	Installing the Java Applet
	Installing the BOSâNOVA Web Spooler

	Logging In
	Running Sessions
	Running a Single Session
	Running All Sessions

	Using the Sessions Table
	Associating Printers
	Viewing Session Properties
	Requesting Help

	Installing Client x.5
	Installing Either Web Client


	Configuring BOSâNOVA Web
	The User Configurator
	Modifying Your Password
	Defining Default Sessions
	Sign-on Bypass
	Working with SSL Certificates
	User SSL Configuration Wizard
	SSL Certificates and BOSâNOVA Web 6.x with Java 2
	Exporting User Certificates
	Importing User Certificates



	The Display Emulation
	Working with the Display Emulation
	Starting the Emulation
	The Emulation Menus
	Session Menu
	Edit Menu
	View Menu
	Macro Menu
	Option Menu
	Help Menu

	Stopping the Emulation
	Saving the Emulation Workspace

	Printing a Screen
	Copying & Pasting
	Viewing Images
	Viewing Full-screen Mode

	Customizing the Display Emulation
	The Emulation Toolbar
	Customizing the Toolbar
	Showing or Hiding the Toolbar

	Display Attributes
	Display Color Attributes
	Exporting Display Properties
	Inserting or Changing the Background Image

	Keyboard Customization
	Viewing a Keyboard Mapping
	Creating or Editing a Keyboard Mapping
	Removing a Keyboard Mapping

	The Emulation Ruler

	Working with Macros
	Opening the Macro Organizer
	Playing a Macro
	From the Macro Organizer
	From the Display Emulation

	Recording a New Macro
	Adding a New Macro
	Viewing a Macro
	Editing a Macro
	Renaming a Macro
	Deleting a Macro
	Exporting and Importing Macros


	MorphMaster
	An Overview of MorphMaster
	Selecting and Deselecting MorphMaster Display

	Excluding Elements from Conversion
	Customizing MorphMaster
	An Overview of MorphMaster Customization
	Customizing from the Style Folder
	Customizing a Color Translation Table
	Customizing the Font
	Customizing the Background Color
	Customizing Color Translation
	Customizing Show Number
	Customizing the Message Line
	Customizing the Design
	Grouping Range
	Customizing the Subfile Style Folder

	Customizing the Rule Base
	General Rule Base
	Menus Rule Base
	Function Keys Rule Base
	Separators
	Subfile Rule Base
	Subfile Options Rule Base
	Titles Rule Base
	Panels Rule Base
	Popup Windows Rule Base



	BOSâNOVA Web Data Transfer Functions (JDTF)
	Introducing JDTF
	Opening JDTF
	Updating the List of Assigned JDTF Profiles
	Working Offline

	Running Data Transfers
	Previewing JDTF Data Before Transfer
	Transferring Data (Running a JDTF Profile)

	Managing JDTF Profiles
	Creating New JDTF Profiles
	Creating a New JDTF Profile List
	Viewing JDTF Profile Properties
	Modifying a JDTF Profile
	Creating a New JDTF Profile Based on an Existing One
	Removing a JDTF Profile

	Assigning JDTF Profiles

	The Printer Emulation
	Overview of Printer Sessions
	Basics of a Printer Session
	Starting and Stopping a Printer Session
	Viewing Printer Session Properties
	Previewing a Print Job


	Printer Session Properties
	Opening the Printer Session Properties
	The General Tab
	Changing the Printer Driver
	Selecting a Printer
	Printing a Test Page
	Changing the Timeout Setting

	Previous Job Attributes Tab
	The Page Setup Tab
	Changing Printer Drawer and Page Settings
	Changing Parameter Control Settings

	Overview of CPI, LPI, and Orientation
	Understanding CPI
	Understanding LPI
	Understanding Orientation

	Font Identifiers
	Determining CPI vs. Font ID Control
	Changing CPI Translation
	Changing Font Translation
	Testing a Printing Configuration

	Diagnostic Tab
	Activating or Changing the Diagnostic Mode
	Collecting Technical Support Information

	Advanced Tab


	Troubleshooting
	Printer Emulation Troubleshooting
	Diagnosing Printing Problems
	Collecting Troubleshooting Information
	Printing Emulation Troubleshooting - Main Flowchart
	Small Characters/Short Lines Flowchart
	Missing Characters Flowchart
	Wrapping Lines Flowchart
	Orientation Problem Flowchart
	Landscape Problem Flowchart
	CPI Problem Flowchart
	Printer Response Problem Flowchart
	Portrait Solutions Problem Flowchart

	Solutions for General Printing Emulation Problems
	Slow Printing
	No Printout
	Zero Bytes
	Printout Doesn’t Fit on the Page
	80-column Output Doesn’t Fit on the Page
	Character Size Not Right


	Error Messages
	JDTF Troubleshooting
	Display Emulation Troubleshooting
	Login Troubleshooting
	User Configurator Troubleshooting
	Macro Editor Troubleshooting
	Keyboard Mapping Troubleshooting

	Uninstalling
	Uninstall for Java 1.4x
	Uninstall for Java 1.5x
	Uninstall for BOSâNOVA Web 4.x
	Microsoft Explorer
	Netscape Navigator



	Host Print Transform
	Host Print Transform
	Understanding Host Print Transform
	Using Host Print Transform


	Windows vs. Custom Driver
	Windows vs. Custom Driver
	Windows vs. Custom Driver
	Using a Custom Driver
	Side-by-Side Comparison

	Selecting or Modifying a Custom Driver
	Selecting a Custom Driver
	Modifying a Custom Driver



	Index and Navigation Tips
	Using the Index
	Links to Index Headings
	Navigation Tips

	Index



<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.3
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /SyntheticBoldness 1.000000
  /Description <<

    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000500044004600206587686353ef901a8fc7684c976262535370673a548c002000700072006f006f00660065007200208fdb884c9ad88d2891cf62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002000d>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef653ef5728684c9762537088686a5f548c002000700072006f006f00660065007200204e0a73725f979ad854c18cea7684521753706548679c300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002000d>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /GRE <>

    /HRV <>
    /HUN <>
    /ITA <>
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020b370c2a4d06cd0d10020d504b9b0d1300020bc0f0020ad50c815ae30c5d0c11c0020ace0d488c9c8b85c0020c778c1c4d560002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e000d>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken voor kwaliteitsafdrukken op desktopprinters en proofers. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /ENU (Use these settings to create Adobe PDF documents for quality printing on desktop printers and proofers.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /NoConversion
      /DestinationProfileName ()
      /DestinationProfileSelector /NA
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure true
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles true
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /NA
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /LeaveUntagged
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


